Contents

- Plumb the Valves—Step-by-Step Instructions .................................................................................................................. 36
- Install the Electrode .............................................................................................................................................................37
- (M5 MicroLC-TE Systems Only) Verify the System Configuration ..................................................................................38
- Load the Mobile Phases ......................................................................................................................................................40
  - Create a Custom Mobile Phase ........................................................................................................................................43
- Flush the Injection Valve ....................................................................................................................................................44
- Allow the Column Oven to Pre-Heat ..................................................................................................................................45
- Test the LC System Connections ......................................................................................................................................45
- Create the LC Methods .......................................................................................................................................................47
  - Create the Gradient Method for a Low-flow System .....................................................................................................47
  - Create the LC Method to Load the Trap Column for a Low-flow System ..................................................................52
  - Create the Gradient Method for Micro-Flow and High-Flow Systems ........................................................................55
  - Create the LC Method to Load the Trap Column for Micro-flow and High-Flow Systems .....................................60

4 Perform a Direct Injection Experiment ..........................................................................................................................64
  - Create the Direct Injection Acquisition Method .........................................................................................................64
  - Create the Acquisition Batch ..........................................................................................................................................67
  - Submit the Batch ............................................................................................................................................................68
  - Monitor the Run ............................................................................................................................................................68
  - (M5 MicroLC-TE Systems Only) Direct Injection Using the Gradient 2 Pump ..........................................................68

5 Perform a Trap-and-Elute Experiment ............................................................................................................................70
  - Create the Trap-and-Elute Acquisition Method ...........................................................................................................70
  - Create the Acquisition Batch ...........................................................................................................................................72
  - Submit the Batch ............................................................................................................................................................73
  - Monitor the Run ............................................................................................................................................................74

6 Routine Maintenance ........................................................................................................................................................75
  - Maintenance Schedule ..................................................................................................................................................75
  - Inspect the System ..........................................................................................................................................................76
  - Dispose of Waste ............................................................................................................................................................76
  - Clean the Surfaces .........................................................................................................................................................76
  - Maintenance Procedures for the Pumps ............................................................................................................................77
    - Re-initialize the Pressure Transducers .........................................................................................................................77
    - Replace the Pump Seal Rinse ........................................................................................................................................78
    - Purge the Mobile Phases and Flush the System .........................................................................................................78
    - Measure the Flow Rate ...............................................................................................................................................80
    - Calibrate the Flowmeters ...........................................................................................................................................81
  - Maintenance Procedures for the Valve ............................................................................................................................83
    - Replace the Injection Port .............................................................................................................................................83
    - Replace the Sample Loop ............................................................................................................................................84
    - Replace the Valve Rotor Seal ......................................................................................................................................84
    - Replace the Valve Pod .................................................................................................................................................88
  - Maintenance Procedures for the Autosampler ................................................................................................................90
    - Replace the Autosampler Wash Solvents ......................................................................................................................90
    - Replace the LCMS Tool Wash Solvent Tubing .........................................................................................................90
    - Prime the LCMS Tool Wash Solvent Tubing .............................................................................................................92
    - Replace the LCMS Tool Pump Module .......................................................................................................................92
Operational Precautions and Limitations

Note: Before operating the system, carefully read all of the sections of this guide.

This section contains general safety-related information and provides regulatory compliance information. It also describes potential hazards and associated warnings for the system and the precautions that should be taken to minimize the hazards.

In addition to this section, refer to Glossary of Symbols for information about the symbols and conventions used in the laboratory environment, on the system, and in this documentation. Refer to the Site Planning Guide for site requirements.

General Safety Information

To prevent personal injury or system damage, read, understand, and obey all of the safety precautions and warnings in this document, the manufacturer chemical safety data sheet (SDS), and product label information. These labels are shown with internationally recognized symbols. Failure to heed these warnings could result in serious injury.

This safety information is intended to supplement federal, state, provincial, and local environmental health and safety (EHS) regulations. It does not cover every safety procedure that should be practised. Ultimately, the user and the organization are responsible for compliance with federal, state, provincial, and local EHS regulations and for maintaining a safe laboratory environment.

Refer to the appropriate laboratory reference material and standard operating procedures.

Regulatory Compliance

This system complies with the regulations and standards listed in this section. Refer to the Declaration of Conformity included with the system and the individual system components for dated references. Applicable labels have been affixed to the system.

Australia and New Zealand

- **Electromagnetic Compatibility (EMC):** Radio Communications Act 1992 as implemented in these standards:
- **Safety:** AS/NZ 61010-1 and IEC 61010-2-081
Operational Precautions and Limitations

Canada

- **Electromagnetic Interference (EMI):** CAN/CSA CISPR11. This ISM device complies with Canadian ICES-001. Refer to Electromagnetic Interference.
- **Safety:**
  - CAN/CSA C22.2 No. 61010-1

Europe

- **Electromagnetic Compatibility (EMC):** Electromagnetic Compatibility directive 2014/30/EU as implemented in these standards:
  - EN 61326-1
  - EN 55011 (Class A)
  Refer to Electromagnetic Compatibility.
- **Safety:** Low Voltage Directives 2014/35/EU as implemented in these standards:
  - EN 61010-1
- **Waste Electrical and Electronic Equipment (WEEE):** Waste Electrical and Electronic Equipment 2012/96/EC, as implemented in EN 40519. Refer to Waste Electrical and Electronic Equipment.
- **Packaging and Packaging Waste (PPW):** Packaging and Packaging Waste Directive 94/62/EC
- **RoHS Restriction of Hazardous Substances:** RoHS Directive 2011/65/EU

United States

- **Radio Emissions Interference Regulations:** 47 CFR 15, as implemented in FCC Part 15 (Class A)
- **Safety:** Occupational Safety and Health Regulations, 29 CFR 1910, as implemented in these standards:
  - UL 61010-1

International

- **Electromagnetic Compatibility (EMC):**
  - IEC 61326-1
  - IEC CISPR 11 (Class A)
  - IEC 61000-3-2
  - IEC 61000-3-3
  Refer to Electromagnetic Compatibility.
• Safety:
  • IEC 61010-1

Electrical Precautions

• Follow required electrical safe work practices.
• Use cable management practices to control electrical cables. This will reduce the chance of a tripping hazard.

For information about system electrical specifications, refer to the Site Planning Guide.

AC Mains Supply

Connect the system to a compatible AC mains supply as instructed in this guide.

WARNING! Electrical Shock Hazard. Use only qualified personnel for the installation of all of the electrical supplies and fixtures, and make sure that all of the installations adhere to local regulations and safety standards.

WARNING! Electrical Shock Hazard. Make sure that the system can be disconnected from the mains supply outlet in an emergency. Do not block the mains supply outlet.

WARNING! Electrical Shock Hazard. Use only the power cables supplied with the system. Do not use power cables that are not properly rated for the operation of this system.

Protective Earth Conductor

The mains supply must include a correctly installed protective earth conductor. The protective earth conductor must be installed or checked by a qualified electrician before the system is connected.

WARNING! Electrical Shock Hazard. Do not intentionally interrupt the protective earth conductor. Any interruption of the protective earth conductor creates an electrical shock hazard.
Chemical Precautions

**WARNING!** Ionizing Radiation Hazard, Biohazard, or Toxic Chemical Hazard. Determine whether decontamination is required prior to cleaning or maintenance. The customer must decontaminate the system prior to cleaning or maintenance if radioactive materials, biological agents, or toxic chemicals have been used with the system.

**WARNING!** Environmental Hazard. Do not dispose of system components in municipal waste. Follow local regulations when disposing of components.

**WARNING!** Fire Hazard. If large amounts of flammable waste solvents are collected, then take preventative measures to minimize the risk of electrical fire due to static electricity.

**CAUTION:** Potential System Damage. Do not submerge the end of the drain tubing in the waste liquid in the waste container.

**CAUTION:** Potential System Damage. Make sure that there are no loops in the drain tubing that goes to the waste container.

- Determine which chemicals have been used in the system prior to service and regular maintenance. Refer to the *Safety Data Sheets* for the health and safety precautions that must be followed with chemicals. SCIEX Safety Data Sheets can be found at sciex.com/tech-regulatory.
- Always wear assigned personal protective equipment, including powder-free neoprene or nitrile gloves, safety glasses, and a laboratory coat.
- Avoid ignition sources when working with flammable materials, such as isopropanol, methanol, and other flammable solvents.
- Take care in the use and disposal of any chemicals. Potential risk of personal injury if proper procedures for handling and disposing of chemicals are not followed.
- Avoid skin contact with chemicals during cleaning and wash hands after use.
- Collect all spent liquids and dispose of them as hazardous waste.
- Comply with all of the local regulations for the storage, handling, and disposal of biohazardous, toxic, or radioactive materials.
System Safe Fluids

The following fluids can safely be used with the system.

Mobile phases should be compatible with the following materials: 316L stainless steel, PTFE, FEP, PEEK, sapphire, glass, and fused silica. The pH of the mobile phases should be between pH 1 and pH 10.

**CAUTION: Potential System Damage.** Do not use any other fluid until confirmation is received from SCIEX that it does not present a hazard. This is not an exhaustive list.

- **Organic Solvents**
  - MS-grade acetonitrile; up to 100%
  - MS-grade methanol; up to 100%
  - Isopropanol; up to 100%
  - HPLC-grade or higher water; up to 100%

- **Buffers**
  - Ammonium acetate; less than 1%
  - Ammonium formate; less than 1%

- **Acids and Bases**
  - Formic acid; less than 1%
  - Acetic acid; less than 1%
  - Trifluoroacetic acid (TFA); less than 1%
  - Heptafluorobutyric acid (HFBA); less than 1%
  - Ammonia/ammonium hydroxide; less than 1%

Environmental Precautions

Use qualified personnel for the installation of electrical mains, heating, ventilation, and plumbing supplies and fixtures. Make sure that all of the installations comply with local bylaws and biohazard regulations. For information about the required environmental conditions for the system, refer to the *Site Planning Guide*.

Allow access space around the equipment when setting up the system.

**WARNING! Biohazard.** For biohazardous material use, always comply with local regulations for hazard assessment, control, and handling. This system or any part is not intended to act as a biological containment.
Electromagnetic Environment

Electromagnetic Compatibility

Basic Electromagnetic Environment: Environment existing at locations characterized by being supplied directly at low voltage from the public mains network.

Performance Criteria A (Criteria A): Equipment shall operate as intended with no degradation of performance and no loss of function during or after test.

Performance Criteria B (Criteria B): Equipment may experience loss of function (one or more) during test but shall operate as intended with some degradation of performance and functions self-recoverable after test.

Performance Criteria C (Criteria C): Equipment may experience loss of function (one or more) during test but shall operate as intended with some degradation of performance and functions recoverable by operator after test.

The equipment is intended for use in a basic electromagnetic environment.

Make sure that a compatible electromagnetic environment for the equipment can be maintained so that the device will perform as intended. If the power supply line is subject to high electrical noise, then install a surge protector.

Electromagnetic Interference

Class A Equipment: Equipment which is suitable for use in all establishments other than domestic and those directly connected to a low voltage power supply network which supplies buildings used for domestic purposes. [Derived from CISPR 11:2009, 5.3] Class A equipment shall meet Class A limits.

This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of the FCC (Federal Communications Commission) Compliance Rules.

These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the operator’s manual, can cause harmful interference to radio communications.

Operation of this equipment in a residential area is likely to cause harmful interference in which case you will be required to correct the interference, at your own expense. Changes or modifications not expressly approved by the manufacturer could void your authority to operate the equipment.
Decommissioning and Disposal

Before decommissioning, decontaminate the entire system following local regulations.

When removing the system from service, separate and recycle different materials according to national and local environmental regulations.

Note: SCIEX will not accept any system returns without a completed Decontamination Form. Contact an FSE to obtain a copy of the form.

Do not dispose of system components or subassemblies, including computer parts, as unsorted municipal waste.

Waste Electrical and Electronic Equipment

Follow local municipal waste ordinances for proper disposal provisions to reduce the environmental impact of waste, electrical, and electronic equipment (WEEE). To safely dispose of this equipment, contact a local Customer Service office for complimentary equipment pick-up and recycling.

Equipment Use and Modification

WARNING! Electrical Shock Hazard. Do not remove the covers. Removing the covers might cause injury or malfunctioning of the system. The covers need not be removed for routine maintenance, inspection, or adjustment. Contact a SCIEX Field Service Employee (FSE) for repairs that require the covers to be removed.

WARNING! Personal Injury Hazard. Use SCIEX-recommended parts only. Use of parts not recommended by SCIEX or use of parts for any purpose other than their intended purpose can put the user at risk of harm or negatively impact system performance.

WARNING! Lifting Hazard. Make sure that at least four people or a lifting device are available to lift the LC system. Follow established safe lifting procedures. Refer to the Site Planning Guide for the weights of system components.

WARNING! Crushing Hazard. Wear protective footwear when moving heavy objects.

WARNING! Puncture Hazard. Keep hands and loose objects away from the autosampler arm and syringe assembly during operation.
Operational Precautions and Limitations

Use the system indoors in a laboratory that complies with the environmental conditions recommended in the *Site Planning Guide*.

If the system is used in an environment or in a manner not prescribed by the manufacturer, then the protection provided by the equipment might be impaired.

Unauthorized modification or operation of the system might cause personal injury and equipment damage, and might void the warranty. Erroneous data might be generated if the system is operated either above or below the recommended environmental conditions or operated with unauthorized modifications. Contact an FSE for information on servicing the system.

Qualified Personnel

Only qualified SCIEX personnel shall install, inspect, and service the equipment. After installing the system, the Field Service Employee (FSE) uses the *Customer Familiarization Checklist* to orient the customer on system operation, cleaning, and basic maintenance.

Contact Us

SCIEX Support

- sciex.com/contact-us
- sciex.com/request-support

Customer Training

- In North America: NA.CustomerTraining@sciex.com
- In Europe: Europe.CustomerTraining@sciex.com
- Outside the EU and North America, visit sciex.com/education for contact information.

Online Learning Center

- SCIEXUniversity

CyberSecurity

For the latest guidance on cybersecurity for SCIEX products, visit sciex.com/productsecurity.
Related Documentation

To find software product documentation, refer to the release notes or software installation guide that comes with the software. Documentation for the hardware products can be found on the Customer Reference DVD that comes with the system or component.

For the latest versions of the documentation, visit the SCIEX website at sciex.com.

Technical Support

SCIEX and its representatives maintain a staff of fully-trained service and technical specialists located throughout the world. They can answer questions about the system or any technical issues that might arise. For more information, visit the SCIEX website at sciex.com.

Documentation Symbols and Conventions

The following symbols and conventions are used throughout the guide.

- **DANGER!** Danger signifies an action which leads to severe injury or death.

- **WARNING!** Warning signifies an action that could cause personal injury if precautions are not followed.

- **CAUTION:** Caution signifies an operation that could cause damage to the system or corruption or loss of data if precautions are not followed.

- **Note:** Note emphasizes significant information in a procedure or description.

- **Tip!** Tip provides useful information that helps apply the techniques and procedures in the text for a specific need and provides shortcuts, but is not essential to the completion of a procedure.
This guide describes the basic operation and critical parameters to consider for routine and robust operation of the SCIEX M5 MicroLC systems.

System Description

The M5 MicroLC system can perform direct injection experiments. It includes:

- Binary gradient pumping system with one of three flow rate configurations:
  - Low-flow—1 µL/min to 10 µL/min
  - Micro-flow—5 µL/min to 50 µL/min
  - High-flow—20 µL/min to 200 µL/min
- 6-port stainless-steel injection valve
- Solvent rack with multiple mounting options
- System accessory kit, with sample loops, a column, fittings, and other supplies
- Integrated CTC Analytics CTC PAL 3 autosampler, including:
  - Three cooled sample drawers
  - LCMS tool for high throughput with low carryover

The M5 MicroLC-TE system can perform trap-and-elute or direct injection experiments. It includes all of the above, as well as:

- A second binary gradient pump configured for 20 µL/min to 200 µL/min flow rates
- A 6-port stainless-steel auxiliary valve
- A trap column

Channel Assignments in the Eksigent Control Software

The M5 MicroLC and M5 MicroLC-TE systems have one and two pump channels, respectively. The pumps are identified in this guide and in the software as Gradient 1 and Gradient 2.
In the software, select the channel in an active dialog or window by clicking the arrow beside the channel. The channel typically shows in the top right corner of a dialog or window. Refer to Figure 2-1.

**Figure 2-1 Channel Selection Controls**

![Channel Selection Controls](image)

**Theory of Operation**

The M5 MicroLC system is a high-pressure liquid chromatography (HPLC) system optimized for analysis at flow rates from 1 µL/min to 200 µL/min. The system incorporates the Microfluidic Flow Control™ system technology (MFC) to generate precise LC gradients at microflow rates. The system also includes the CTC PAL 3 autosampler with the LCMS tool designed to minimize sample carryover.

**Microfluidic Flow Control™ System Technology**

The Microfluidic Flow Control™ system technology (MFC) has two primary benefits:

- precise gradients at microliter-per-minute rates without flow splitting
- extremely rapid response to changes in flow enabling fast gradients and dynamic flow control

The components of a binary gradient MFC system are shown schematically in the following figure. Refer to Figure 2-2.

**Figure 2-2 Microfluidic Flow Control™ System Components**

![Microfluidic Flow Control™ System Components](image)
### How the Microfluidic Flow Control™ System Technology Works

For each mobile phase:

1. The flowmeter continuously monitors the flow rate and sends signals to the PID controller, a control loop feedback device.
2. The PID controller automatically adjusts the pump pressure to deliver the required flow rate.
3. The air pressure to each pump is controlled separately to provide accurate flow rates at pressures up to 10,000 psi.

### The LCMS Tool on the CTC PAL 3 Autosampler

The LCMS tool is part of the CTC PAL 3 autosampler and consists of the syringe and syringe needle, a holding loop, two pumps, two wash solvents, and associated tubing. The LCMS tool helps prevent carryover in three ways:

- The system is designed so that the sample only comes in contact with the needle and the holding loop.
- Small volumes of air can be used to bracket both sides of the sample plug, preventing the sample from diffusing into the solvent.
- At the end of the injection, all parts of the system that have been in contact with the sample are washed with both organic and aqueous wash solvents.
The LCMS Tool Syringe Needle and Holding Loop

Figure 2-3 Holding Loop and Syringe Needle, Showing Location of Sample and Airgaps

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Holding loop</td>
<td>4</td>
<td>Injection Volume (sample)</td>
</tr>
<tr>
<td>2</td>
<td>Rear Airgap Volume (air)</td>
<td>5</td>
<td>Front Volume (sample)</td>
</tr>
<tr>
<td>3</td>
<td>Rear Volume (sample)</td>
<td>6</td>
<td>Front Airgap Volume (air)</td>
</tr>
</tbody>
</table>

Bold text in Figure 2-3 indicates user-settable volumes:

- The Injection Volume is set in the acquisition batch in the Analyst® software.
- The Front and Rear Airgap Volumes can be set in all three of the autosampler scripts supplied with the M5 MicroLC system.
About Partial- and Full-loop Injections

Depending on the sample loop that is installed on the system and the volume of sample available, the sample loop can either be partially or completely filled. Full loop injections typically give the best quantitative results, but require overfilling of the sample loop and therefore result in some sample waste. In full loop injections the sample volume is determined by the volume of the sample loop itself. Partial loop injections allow for variable injection volumes without changing the sample loop and the injection volume is determined by the autosampler parameters. Partial loop injections might have slightly higher variability, but can be conducted with minimal sample waste.

In the M5 MicroLC system, the default position of the sample loop on the injection valve at the start of a new method is in the load position. The loop must be full of a solvent that will allow the sample to be retained on the trap or column (typically this is the starting composition of the LC method), particularly for a partial-loop injection where the front volume is 0. The final steps of the Gradient 1 LC method return the sample loop to the initial conditions. Refer to Figure 3-21 and Figure 3-29.

Partial-loop Injections

For a partial-loop injection, the autosampler script specifies that the autosampler will pick up a rear airgap (air), a rear volume (sample), and the specified volume of sample. Refer to Figure 2-4. The rear airgap isolates the sample from the transfer liquid of the autosampler and the rear volume prevents the airgap from entering the sample loop. (Airgap volumes are typically between 1 µL to 3 µL and the rear volume is typically 1 µL of sample.) The sample volume is the amount of sample to be injected in the experiment and is less than the volume of the sample loop.

### Figure 2-4 Schematic Drawing of Partial-Loop Injection

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Sample loop</td>
<td>4</td>
<td>Sample volume</td>
</tr>
<tr>
<td>2</td>
<td>Rear air gap</td>
<td>5</td>
<td>Mobile phase</td>
</tr>
<tr>
<td>3</td>
<td>Rear volume</td>
<td>6</td>
<td>Direction of flow</td>
</tr>
</tbody>
</table>
In a partial-loop injection, the amount of sample dispensed is less than the total volume of the sample loop. As a result, the sample loop is only partially filled with sample, with the remainder of the loop filled with mobile phase.

**Full-loop Injections**

In a full-loop injection, the autosampler script specifies a rear airgap, a rear volume, the sample volume, a front volume and a front airgap. Refer to Figure 2-5. The front volume and front airgap help to limit the sample mixing with the liquid originally in the loop and the rear airgap and rear volume act as in a partial-loop injection.

Figure 2-5 Schematic Drawing of Full-Loop Injection

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Sample loop</td>
<td>5</td>
<td>Front volume</td>
</tr>
<tr>
<td>2</td>
<td>Rear air gap</td>
<td>6</td>
<td>Front air gap</td>
</tr>
<tr>
<td>3</td>
<td>Rear volume</td>
<td>7</td>
<td>Direction of flow</td>
</tr>
<tr>
<td>4</td>
<td>Sample volume</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

In a full-loop injection, the amount of sample dispensed is greater than the total volume of the sample loop.

For either type of injection, parameters in the autosampler script define the volumes and the airgaps. Refer to Parameters for the Autosampler Script for more information.

**Injection Modes**

For both partial-loop and full-loop injections, there are four modes of sample injection. They differ in whether the sample loop stays in-line during the acquisition and how much of the contents of the sample loop is transferred to the column. The injection mode is selected in the Run Conditions tab in LC Method Settings dialog. Refer to Figure 2-6.
Figure 2-6 LC Method Settings Dialog—Sample Injection Section

- None—the sample valve does not switch during the acquisition.
- Standard—the sample valve switches to the inject position when acquisition begins and returns to the load position when acquisition ends. The sample loop remains in the flow path during acquisition.
- Metered—the valve switches to the inject position when acquisition starts, and then the specified volume of sample is delivered to the column. After the specified volume is injected, the sample valve switches to the load position, removing the sample loop from the flow path.

Use metered injection when the sample loop volume is larger than the volume to be injected on the column. This prevents the large sample loop from adding extra dead-volume and peak broadening.

The minimum injection volume (in nanoliters) is given by 2.5 x Q, where Q is the flow rate. To inject a smaller volume, decrease the flow rate in the LC method.

- Rapid—the valve operates as for a metered injection, except the flow rate increases during the injection to inject the sample quickly and prevent extra-column broadening.

About the Autosampler Script

The Analyst® software uses the autosampler script to communicate with the autosampler. The autosampler script is part of the acquisition method.

The appropriate script depends on the type of experiment to be performed:

- For a direct injection experiment: M5_Direct Inject
- For a trap-and-elute experiment: M5_TrapElute

By default, both of these scripts are for partial-loop injections. Refer to Table 2-1 for the necessary changes for a full-loop injection.

Note: An additional autosampler script is supplied with the system, M5_Advanced. This script allows expanded control over more autosampler functions. Refer to Parameters for the Advanced Autosampler Script. For most situations, M5_Direct Inject or M5_TrapElute are sufficient.
Steps in the Autosampler Script

The autosampler script consists of the following steps:

1. Aspirate the sample, then, optionally, dip the needle in wash solvent 1 and wash solvent 2.
2. Move the needle to the injection port on the valve.
3. Load the sample on the injection loop, then switch the valve to inject the sample onto the column.
4. Wash the system:
   a. Wash the injection valve and needle with the specified wash solvent, typically the organic wash solvent.
   b. Wash the injection valve and needle with the specified wash solvent, either the aqueous wash solvent or the organic wash solvent, for a second time.
5. Optionally, wash the injection valve and needle again with the specified wash solvent, typically the aqueous wash solvent.

**Note:** If the first two wash steps use the organic wash solvent, then a final aqueous wash step is recommended. (Wash solvents are selected in the Instrument Method Editor window in Analyst® Device Driver. The parameters are **First Wash Solvent** and **Second Wash Solvent**, and the options are 1 and 2, where the numbers correspond to the labels on the tubing from the LCMS tool pumps.)
6. Move the needle to the home position.

**Parameters for the Autosampler Script**

Parameters for the autosampler script are set in the Parameters Setup Tab in the Instrument Control Method Editor window in the Analyst® Device Driver. Refer to Table 2-1 for recommended values for the parameters and their ranges.

**Note:** The values with an asterisk ("*") in the following table are mandatory. Use the values in the Recommended Value column.

**Table 2-1 Parameters in the Parameter Setup Tab—Direct Injection and Trap and Elute Autosampler Scripts**

<table>
<thead>
<tr>
<th>Parameter Name</th>
<th>Recommended Value</th>
<th>Minimum Value</th>
<th>Maximum Value</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>General Setting Section</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Tool*</td>
<td>LCP1</td>
<td>LCP1</td>
<td></td>
</tr>
<tr>
<td>Pump Module*</td>
<td>Pump 1</td>
<td>Pump 1</td>
<td></td>
</tr>
<tr>
<td>Cooled Stack*</td>
<td>Peltier Stack 1</td>
<td>Peltier Stack 1</td>
<td></td>
</tr>
<tr>
<td>Bottom Sensing Sample Vial (see note)</td>
<td>Off</td>
<td>Off or On</td>
<td></td>
</tr>
<tr>
<td>Height from Bottom of Sample Vial (mm)</td>
<td>2</td>
<td>0</td>
<td>32</td>
</tr>
<tr>
<td>Sample Temperature (°C)</td>
<td>8</td>
<td>4</td>
<td>40</td>
</tr>
<tr>
<td><strong>Sample Parameter Section</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Front Air Gap (µL)</td>
<td>3</td>
<td>0</td>
<td>3</td>
</tr>
<tr>
<td>Rear Air Gap (µL)</td>
<td>3</td>
<td>1</td>
<td>3</td>
</tr>
<tr>
<td>Sample Aspirate Flow Rate (µL/s)</td>
<td>10</td>
<td>0.1</td>
<td>50</td>
</tr>
<tr>
<td><strong>Injection Parameter Section</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Injector*</td>
<td>Injector LC 1</td>
<td>Injector LC 1</td>
<td></td>
</tr>
<tr>
<td>Sample Injector Flow Rate (µL/s)</td>
<td>5</td>
<td>0.1</td>
<td>10</td>
</tr>
<tr>
<td><strong>Wash Parameter Section</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Wash Station*</td>
<td>LCMS Wash 1</td>
<td>LCMS Wash 1</td>
<td></td>
</tr>
<tr>
<td>PreDip in Aqueous</td>
<td>1</td>
<td>0</td>
<td>2</td>
</tr>
<tr>
<td>PreDip in Organic</td>
<td>0</td>
<td>0</td>
<td>2</td>
</tr>
</tbody>
</table>
### Table 2-1 Parameters in the Parameter Setup Tab—Direct Injection and Trap and Elute Autosampler Scripts (continued)

<table>
<thead>
<tr>
<th>Parameter Name</th>
<th>Recommended Value</th>
<th>Minimum Value</th>
<th>Maximum Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>First Wash Solvent</td>
<td>2</td>
<td>1</td>
<td>2</td>
</tr>
<tr>
<td>Second Wash Solvent</td>
<td>1</td>
<td>1</td>
<td>2</td>
</tr>
<tr>
<td>Clean Valve Time with First Wash Solvent (s)</td>
<td>2</td>
<td>2</td>
<td>10</td>
</tr>
<tr>
<td>Clean Valve Time with Second Wash Solvent (s)</td>
<td>2</td>
<td>2</td>
<td>10</td>
</tr>
<tr>
<td>Clean Syringe Cycle with First Wash Solvent</td>
<td>1</td>
<td>0</td>
<td>10</td>
</tr>
<tr>
<td>Clean Syringe Cycle with Second Wash Solvent</td>
<td>1</td>
<td>0</td>
<td>10</td>
</tr>
<tr>
<td>Final Clean</td>
<td>Off</td>
<td>Off or On</td>
<td></td>
</tr>
<tr>
<td>Final Clean with Wash Solvent</td>
<td>1</td>
<td>1</td>
<td>2</td>
</tr>
</tbody>
</table>

**Note:** The Bottom Sensing Sample Vial option might not be compatible with some vials, particularly glass inserts. If a different type of vial is to be used, then run a test sample using the new vial and make sure that the results are acceptable before setting up a complete run.
Set Up the System to Run an Experiment

This chapter describes the steps to prepare the M5 MicroLC system to run an experiment using the Analyst® software. The procedures are similar for direct injection and trap-and-elute experiments with any differences noted. The procedures described in this chapter assume the system has already been properly installed and initialized.

Complete the following steps in the order in which they appear:

- Verify the Hardware Profile
- Plumb the Injection Valve
- (M5 MicroLC-TE Systems Only) Verify the System Configuration
- Load the Mobile Phases
- Flush the Injection Valve
- Allow the Column Oven to Pre-Heat
- Test the LC System Connections
- Create the LC Methods

Note: The screen captures shown in this chapter are for the M5 MicroLC-TE system. For a M5 MicroLC system, the screens are slightly different.

Verify the Hardware Profile

The active hardware profile in the Analyst® software must include the autosampler, the Analyst® Device Driver and the M5 MicroLC pump. For an M5 MicroLC-TE, there are two pumps. However, if a different computer is being used or the Analyst® software has been uninstalled, then the hardware profile might not be correct. Use these steps to verify the hardware profile.

1. Close the Eksigent Control software.
2. Open the Analyst® software.
3. On the Navigation bar, under Configure, double-click Hardware Configuration.
4. In the Hardware Configuration Editor dialog, click each hardware profile to open it and locate a profile that contains a mass spectrometer, the Analyst Device Driver for the autosampler, and the Eksigent Control software.
5. If the profile does not have a green check to the left, click **Activate Profile**.

The active profile is shown with a check, the Eksigent Control software launches and the Acquisition window opens. If the window does not open (indicating that the Eksigent Control software did not start), then close the Analyst® software.

6. Close the Hardware Profile window.

   **Note:** Do not start the Eksigent Control software manually. Instead, allow the Analyst® software to start the Eksigent Control software. (When the Eksigent Control software is started manually, the LC Methods button is replaced with the Run Manager button.)

### Create a Hardware Profile

The active hardware profile must include the autosampler, the Analyst® Device Driver and the M5 MicroLC pump. For an M5 MicroLC-TE, there are two pumps. Create a hardware profile if an appropriate profile does not already exist.
Set Up the System to Run an Experiment

1. Close the Eksigent Control software.
2. Open the Analyst® software.
3. On the Navigation bar, under Configure, double-click Hardware Configuration.
4. Click New Profile.

Figure 3-2 Create New Hardware Profile Dialog

5. Type a name in the Profile Name field.
6. Add the mass spectrometer to the profile.
   a. Click Add device.
   b. Select Mass Spectrometer in the Device Type list.
   c. Click the appropriate mass spectrometer in the list and then click OK.

   Tip! The correct mass spectrometer is usually highlighted in the list.

7. Configure the profile for the Analyst® Device Driver.
   a. Click Software Application <not configured>.
   b. Click Setup Device to open the Software Application Settings dialog.
c. Click Analyst Device Driver and then click OK.

8. Configure the profile for the Gradient 1 pump.
   a. Click Software Application <not configured>.
   b. Click Setup Device to open the Software Application Settings dialog.

   **Note:** If nothing is listed in the Software applications list in the Software Application Settings dialog, the Eksigent driver for the Analyst® software is not installed. Follow the instructions in step 5 of Install the Eksigent Control Software and Transfer the Settings to install the driver (omit the step for the settings).

   c. Click Gradient 1 and then click OK.

9. For an M5 MicroLC-TE system, repeat step 8 to configure the second pump (click Gradient 2).

**Figure 3-3 Software Application Settings Dialog—M5 MicroLC-TE System**

10. Click OK to save the profile.

11. If the profile does not have a green check to the left, then click Activate Profile.

12. Click Close.

   The active profile is shown with a check and the Analyst® Device Driver and Eksigent Control software both launch. In the Eksigent Control software, the Acquisition window opens.
Set Up the System to Run an Experiment

Figure 3-4 Analyst® Device Driver

Figure 3-5 Eksigent Control Software Acquisition Window Started from Analyst Software

Note: Do not start the Eksigent Control software manually. Instead, allow the Analyst® software to start the Eksigent Control software. (When the Eksigent Control software is started manually, the LC Methods button is replaced with the Run Manager button.)
Plumb the Injection Valve

The M5 MicroLC system is plumbed differently depending on the type of experiment:

- For a direct injection experiment, refer to Direct Injection Plumbing Diagram.
- For a trap-and-elute experiment, refer to Trap-and-Elute Plumbing Diagram.

For either type of experiment, a different column, trap column, or sample loop may be installed as appropriate for the experimental conditions.
Direct Injection Plumbing Diagram

Direct injection experiments can be performed on either an M5 MicroLC-TE or an M5 MicroLC-TE system.

Figure 3-6 Injection Valve Plumbing for Direct Injection Experiments

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Stainless-steel tubing 250 µm i.d., 1/32 inch o.d., 10 cm</td>
<td>5065316</td>
</tr>
<tr>
<td>2</td>
<td>Gray tubing, 50 µm i.d., 1/32 inch o.d., 10 cm</td>
<td>205-00069</td>
</tr>
<tr>
<td>3</td>
<td>Low- or micro-flow systems: Kinetex 2.6 µm 100 Å XB-C18 0.3 mm i.d. x 5 cm column Micro- or high-flow systems: Kinetex 2.6 µm 100 Å XB-C18 0.5 mm i.d. x 5 cm column Black PEEK fittings</td>
<td>5062189 5062190 200-00342</td>
</tr>
<tr>
<td>4</td>
<td>Gray tubing, 50 µm i.d., 1/32 inch o.d., 50 cm (shorter or longer as necessary)</td>
<td>205-00041</td>
</tr>
<tr>
<td>5</td>
<td>5 µL sample loop (loops with other volumes can be used)</td>
<td>5017799</td>
</tr>
<tr>
<td>6</td>
<td>Injection port</td>
<td>5052374</td>
</tr>
</tbody>
</table>

For all connections before the analytical column, use gold-colored nuts (PN 5024174) and ferrules (PN 910-00087).
Trap-and-Elute Plumbing Diagram

Trap-and-elute experiments can only be performed on the M5 MicroLC-TE system.

Figure 3-7 Injection Valve Plumbing for Trap-and-Elute Experiments

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Gray tubing, 50 µm i.d., 1/32 inch o.d., 20 cm</td>
<td>205-00039</td>
</tr>
<tr>
<td>2</td>
<td>Stainless-steel tubing, 250 µm i.d., 1/32 inch o.d., 10 cm</td>
<td>5065316</td>
</tr>
<tr>
<td>3</td>
<td>Low- or micro-flow systems: Kinetex 2.6 µm 100 Å XB-C18 0.3 mm i.d. x 5 cm column</td>
<td>5062186</td>
</tr>
<tr>
<td></td>
<td>Micro- or high-flow systems: Kinetex 2.6 µm 100 Å XB-C18 0.5 mm i.d. x 5 cm column</td>
<td>5062190</td>
</tr>
<tr>
<td></td>
<td>Black PEEK fittings</td>
<td>200-00342</td>
</tr>
<tr>
<td>4</td>
<td>Gray tubing, 50 µm i.d., 1/32 inch o.d., 50 cm (shorter or longer as necessary)</td>
<td>205-00041</td>
</tr>
<tr>
<td>5</td>
<td>Luna C18 (2) 5 µm 100 Å 0.3 mm i.d. x 2 cm trap column</td>
<td>5062186</td>
</tr>
<tr>
<td></td>
<td>Two pieces of PEEK-clad fused silica tubing, 50 µm i.d., 1/32 inch o.d., 15 cm</td>
<td>205-00038</td>
</tr>
<tr>
<td>6</td>
<td>Gray tubing, 50 µm i.d., 1/32 inch o.d., 10 cm</td>
<td>205-00069</td>
</tr>
<tr>
<td>7</td>
<td>50 µL stainless steel sample loop</td>
<td>5040770</td>
</tr>
<tr>
<td>8</td>
<td>Injection port</td>
<td>5052374</td>
</tr>
</tbody>
</table>

For all connections before the analytical column, use gold-colored nuts (PN 5024174) and ferrules (PN 910-00087).
Set Up the System to Run an Experiment

Post-Column Plumbing

**Note:** The following instructions apply only to mass spectrometers using the Turbo V™ or DuoSpray™ ion source. For mass spectrometers using the OptiFlow™ Turbo V ion source, refer to the *OptiFlow™ Turbo V Ion Source Operator Guide.*

**Note:** The electrodes, fittings, and tubing required for the Turbo V™ or DuoSpray™ ion source are not included with the M5 MicroLC system and must be purchased separately from SCIEX. Refer to Order Parts.

Plumbing details after the column vary based on the ion source electrode in use. Refer to Table 3-1 to select the appropriate electrode for the planned flow rate.

**WARNING!** Electrical Shock Hazard: For the Turbo V™ or DuoSpray™ ion source, use a red fitting at the ion source electrode to reduce the risk of electrical shock. Do not use conductive fittings such as the high-pressure carbon-filled black fittings.

**WARNING!** Electrical Shock Hazard. Do not bypass the grounding union connection. The grounding union provides grounding between the mass spectrometer and the sample introduction device.

All tubing is 1/32 inch outer diameter (o.d.).
Figure 3-8 Connections—Ion Source Electrodes

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>Part Number</th>
<th>Item</th>
<th>Description</th>
<th>Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Orange 25 µm i.d. tubing, 10 cm</td>
<td>205-00091</td>
<td>6</td>
<td>50 µm i.d. electrode</td>
<td>5028466</td>
</tr>
<tr>
<td>2</td>
<td>Red PEEK fitting</td>
<td>200-00330</td>
<td>7</td>
<td>Gray 50 µm i.d. tubing, 5 cm</td>
<td>205-00070</td>
</tr>
<tr>
<td>3</td>
<td>25 µm i.d. electrode</td>
<td>5028467</td>
<td>8</td>
<td>Stainless steel grounding union</td>
<td>5016413</td>
</tr>
<tr>
<td>4</td>
<td>Grounding cable</td>
<td>5016435</td>
<td>9</td>
<td>65 µm i.d. electrode</td>
<td>5029342</td>
</tr>
<tr>
<td>5</td>
<td>Gray 50 µm i.d. tubing, 10 cm</td>
<td>205-00069</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Plumb the Valves–Step-by-Step Instructions

**WARNING!** Electrical Shock Hazard: For the Turbo V™ or DuoSpray™ ion source, use a red fitting at the ion source electrode to reduce the risk of electrical shock. Do not use conductive fittings such as the high-pressure carbon-filled black fittings.

**WARNING!** Beware of burns. The column oven becomes hot during operation.

Before plumbing the valves, read Working with PEEK-clad Fused Silica Tubing.

Unless otherwise noted, all connections are made with gold-colored nuts and ferrules.

1. Plumb port 2 on the injection valve with 10 cm of 0.010 inch (250 µm) i.d., 1/32 inch o.d. stainless steel tubing and then put the other end in the waste drain.

2. Install the sample loop in ports 1 and 4 on the injection valve using a 3/16 inch wrench.
   - For a direct injection experiment: Use a 5 µL sample loop.
   - For a trap-and-elute experiment: Use a 50 µL sample loop.

   **Note:** Do not use the fittings included with the loop.

3. For a direct injection experiment, plumb the G1 pump outlet to port 6 on the injection valve with 10 cm of 50 µm i.d., 1/32 inch o.d. tubing.

4. For a trap-and-elute experiment, use 10 cm of 50 µm i.d., 1/32 inch o.d. tubing and plumb the pump outlets as follows:
   - G2 pump outlet to port 6 on the injection valve.
   - G1 pump outlet to port 5 on the auxiliary valve.

5. For a trap-and-elute experiment, install the trap column and then plumb the auxiliary valve.
   a. Install the trap column in ports 1 and 4 on the auxiliary valve. For each connection, use 15 cm of 50 µm i.d., 1/32 inch o.d. tubing and the nuts supplied with the trap column.
   b. Put the trap column in the trap column holder on the valve basin.
   c. Plumb port 2 on the auxiliary valve with 10 cm of 0.010 inch (250 µm) i.d., 1/32 inch o.d. stainless steel tubing and put the other end in the waste drain.
   d. Connect port 5 on the injection valve to port 3 on the auxiliary valve with 20 cm of 50 µm i.d., 1/32 inch o.d. tubing.
6. Connect the valve to the column inlet using 50 cm of 50 µm i.d., 1/32 inch o.d. tubing, and a black PEEK fitting at the column inlet. The valve and port depend on the type of experiment:

- For a direct injection experiment: Port 5 on the injection valve.
- For a trap-and-elute experiment: Port 6 on the auxiliary valve.

**Tip!** If necessary to accommodate the laboratory layout, longer tubing can be used, but make the length of the tubing from the valve to the column as short as possible.

7. If necessary, install the electrode in the ion source probe. For the Turbo V™ or DuoSpray™ ion source, refer to Install the Electrode. For the OptiFlow™ Turbo V ion source, refer to the OptiFlow™ Turbo V Ion Source Operator Guide.

8. For the OptiFlow™ Turbo V ion source, install the column.
   a. Connect the column to the ion source probe. Tighten the fitting until it is finger-tight.
   b. Install the column oven on the ion source. Refer to the OptiFlow™ Turbo V Ion Source Operator Guide.

9. For the Turbo V™ or DuoSpray™ ion source, install the column and then ground the electrode.
   a. Connect the column to the ion source electrode using a black PEEK fitting at the column outlet, two pieces of tubing connected by a grounding union after the column, and a red PEEK fitting at the electrode. Refer to Post-Column Plumbing.
   b. Clip one end of the grounding cable to the grounding point on the ion source.
   c. Clip the other end of the grounding cable as follows:
      - 25 µm and 50 µm i.d. electrodes: Clip to the grounding union on the probe.
      - 65 µm i.d. electrodes: Clip to the grounding union installed on the tubing after the column.
   d. Put the column in the column oven.
   e. Cut a piece of the foam block from the column oven kit and then put it on top of the column to hold the column securely against the metal surface of the oven for good thermal contact.
   f. Close the column oven.

**Install the Electrode**

**Note:** The following instructions apply only to mass spectrometers using the Turbo V™ or DuoSpray™ ion source. For mass spectrometers using the OptiFlow™ Turbo V ion source, refer to the OptiFlow™ Turbo V Ion Source Operator Guide.
Set Up the System to Run an Experiment

The smaller columns used in micro ultra-high performance liquid chromatography require lower flow rates and smaller electrodes than traditional liquid chromatography. Depending on the planned flow rates for the system, install the appropriate electrode in the Turbo V™ or DuoSpray™ ion source probe.

Table 3-1 Suggested Electrode by Flow Rate

<table>
<thead>
<tr>
<th>Flow Rate (µL/min)</th>
<th>Electrode</th>
</tr>
</thead>
<tbody>
<tr>
<td>5 to 20</td>
<td>25 µm i.d.</td>
</tr>
<tr>
<td>20 to 50</td>
<td>50 µm i.d.</td>
</tr>
<tr>
<td>20 to 100</td>
<td>65 µm i.d.</td>
</tr>
</tbody>
</table>

Note: The upper limit for the flow rate is ultimately determined by the pressure limits of the system and the column.

1. Replace the existing spring with the one provided with the electrode.
2. Install the electrode in the Turbo V™ or DuoSpray™ probe in the same manner as the standard larger i.d. electrode.
3. Tighten the black screw cap on the probe and then adjust as necessary to extend the electrode tip 1 mm to 2 mm past the probe tip.

(M5 MicroLC-TE Systems Only) Verify the System Configuration

For M5 MicroLC-TE systems, the plumbing and settings in the Eksigent Control software depend on the type of experiment. Make sure that the system is set up correctly for the type of experiment to be performed.

1. Make sure that the valve is correctly plumbed for the type of experiment to be performed.
   - Direct Injection Plumbing Diagram
   - Trap-and-Elute Plumbing Diagram
2. Set the mode in the Direct Control dialog.
   a. Select System > Direct Control.
b. For a direct injection experiment, make sure that the **Trap-Elute Mode** check box is not selected.

**Figure 3-9 Direct Control Dialog–Direct Inject Mode**
c. For a trap-and-elute experiment, make sure that the **Trap-Elute Mode** check box is selected.

![Figure 3-10 Direct Control Dialog—Trap-and-Elute Mode](image)

**Figure 3-10 Direct Control Dialog—Trap-and-Elute Mode**

```
d. Click Close.
```

## Load the Mobile Phases

**Note:** We do not recommend using Milli-Q water because it is not of suitable quality for use in LC-MS systems.

This procedure assumes that the mobile phases are water and acetonitrile, with water entering the pump at the **Mobile Phase A** inlet (labeled 1A or 2A on the back of the system) and acetonitrile entering the pump through the **Mobile Phase B** inlet (labeled 1B or 2B on the back of the system). In general, the more organic mobile phase should use the B inlet.

Refer to **System Safe Fluids** before using different mobile phases.

1. If necessary, discard any old solvents in the mobile phase bottles, then clean the bottles with the appropriate solvents.
2. Pour new mobile phases in the bottles, then insert the mobile phase tubing and filters.
3. Specify the mobile phase information in the Eksigent Control software.
   a. Click **System > Mobile Phases** to open the Mobile Phases dialog.
b. For Binary Mixture A (mobile phase A), do not make any changes.

c. For Binary Mixture B (mobile phase B), select Acetonitrile in the lower list and then type 100 in the % field.

d. (Optional) Type any comments in the Comment/Modifiers fields.

**Figure 3-11 Mobile Phases Dialog**

![Mobile Phases Dialog]

**Note:** If a mobile phase that is not listed in the Mobile Phases dialog is required, then either select a mobile phase with a very similar viscosity from the list or add a new one. Refer to Create a Custom Mobile Phase for instructions.

4. Purge the pumps a minimum of 20 times.
   a. Click More to display additional options in the dialog.
   b. In the Purge Settings section, select the pumps to be purged and then type 20 in the purge cycles field.
   c. For an M5 MicroLC-TE system, select the Apply to all channels check box.
   d. Click Purge Now.

   The pumps begin to execute purge cycles. While the pumps are purging, make sure that the mobile phases are pulled through the mobile phase tubing to the pumps.

   e. Locate the waste tubing of the pumps being purged. The waste tubes are clear plastic tubing and emerge from the back of the pump. After about 8 purges, the mobile phase should be purged through the waste tubing.
5. Flush the system.
   a. Disconnect the tubing coming from the G1 pump outlet.
   b. Connect one end of a length of 1/32 inch o.d. tubing to the G1 pump outlet and put the other end in the waste drain.
   c. In the **Flush Settings** section, set the parameters based on the system.

<table>
<thead>
<tr>
<th>System</th>
<th>Total Volume (µL)</th>
<th>Flush Flowrate (µL/min)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Low-flow system</td>
<td>100</td>
<td>10</td>
</tr>
<tr>
<td>Micro-flow system</td>
<td>500</td>
<td>50</td>
</tr>
<tr>
<td>High-flow system and all Gradient 2 pumps</td>
<td>500</td>
<td>50</td>
</tr>
</tbody>
</table>

d. Click **Flush Now**.

   e. When the flush sequence ends, click **OK**.

6. Repeat step 5 for the G2 pump outlet. Install the 1/32 inch o.d. tubing from the G1 outlet in the G2 outlet.

7. For each pump, connect the original tubing between the pump outlet and the valve.
Create a Custom Mobile Phase

Some experiments require a mobile phase other than those available in the Eksigent Control software. Add a custom mobile phase in the Mobile Phases dialog. Also, create a custom mobile phase for a mixture of two solvents in one bottle.

1. Click **System > Mobile Phases** to open the Mobile Phases dialog.

**Figure 3-14 Mobile Phases Dialog—Expanded**

2. For an M5 MicroLC-TE system, click the **Channel** buttons to select the pump that will use the new mobile phase.

3. Click **More** to show more options in the dialog.

4. In the **Mobile Phase Change** section, click **Create New Fluid** to open the Flowmeter Calibration dialog. (Adding a custom mobile phase includes performing a flowmeter calibration.)

5. Follow the steps in the Flowmeter Calibration dialog.

   Select the calibration pipette based on the system:
   - Low-flow system: 20 µL
   - Micro-flow system: 100 µL
   - High-flow system: 200 µL
Flush the Injection Valve

Flush the valve when the column is not connected to avoid introducing any contaminants from the valve to the column.

1. Disconnect the tubing from the column inlet.
2. Click System > Direct Control to open the Direct Control dialog.

Figure 3-15 Direct Control Dialog

3. For an M5 MicroLC-TE system, click the Channel buttons to select Gradient 2.
4. Set the Pump Direct Control parameters and then start the pump.
   a. Select the Conserved Flow option.
   b. Set both A (%) and B (%) to 50.
   c. Set the Total flowrate based on the system configuration:
      - For a low-flow system, type 10 µL/min.
      - For micro-flow or high-flow system type 20 µL/min.
   d. Click Start.
5. In the Valve Direct Control section, alternate clicking Load and Inject, waiting approximately 10 seconds between each click, for a total of 3 times.
6. Click Load, then click Stop.
7. Reconnect the tubing to the column inlet.
Allow the Column Oven to Pre-Heat

The temperature of the column can be regulated. The maximum temperature depends on the column heater in use.

- For the OptiFlow™ Turbo V ion source, refer to the *OptiFlow™ Turbo V Ion Source Operator Guide*.
- For the Turbo V™ or DuoSpray™ ion source, the maximum temperature is 60 °C.

**Note:** The column oven reaches the correct temperature quickly, but the column can take as long as 30 minutes to fully equilibrate.

**WARNING!** Hot Surface Hazard. Beware of burns. The column can become hot during operation. Allow the column to cool before removing it or replacing the PEEK clad fused silica tubing.

1. Connect the column.
2. In the Eksigent Control software, click **System > Direct Control**.
3. For a trap-and-elute system, click the **Channel** buttons to select **Gradient 1**.
4. In the **Column Oven/Heater** section, type **35** in the **Setpoint** field, and then click **Start**.

![Figure 3-16 Direct Control Dialog—Column Oven/Heater Section](image)

5. Close the compartment so the oven can reach the specified temperature.

Test the LC System Connections

1. Make sure that the column is connected.
2. Click **System > Direct Control** to open the Direct Control dialog.
3. Set the **Pump Direct Control** parameters.
   a. Select the **Conserved Flow (%)** option.
Set Up the System to Run an Experiment

b. Type 80 in the A field and 20 in the B field.

**Note:** For other experiments, set A and B to match the initial conditions in the LC method to be used in the experiment.

c. Set the **Total flowrate** based on the column diameter.
   - For a 0.3 mm i.d. column, type 10 \( \mu \text{L/min} \).
   - For a 0.5 mm i.d. column, type 40 \( \mu \text{L/min} \).

**Figure 3-17 Direct Control Dialog**

4. In the **Pump Direct Control** section, click **Start** to start the pump.

5. Allow the system to pump for approximately 2 minutes, inspecting the connections for any leaks, and then click **Stop**.

6. For a trap-and-elute experiment, click the **Channel** arrow buttons to select **Gradient 2** and then repeat steps 3 through 5 to test the connections for the other pump. Set the **Total flowrate** to 40 \( \mu \text{L/min} \).

7. Click **Close**.
Create the LC Methods

An LC method contains the conditions used for separating the sample, including flow rate, flow mode, and mobile phase gradient. For a direct injection experiment, one method is required. For a trap-and-elute experiment, two methods are required. Refer to Table 3-2.

**Note:** Make sure to create the method appropriate for the flow rate configuration of the system in use.

### Table 3-2 LC Methods

<table>
<thead>
<tr>
<th>Type of Experiment</th>
<th>Low-flow System</th>
<th>Micro-flow or High-flow System</th>
</tr>
</thead>
<tbody>
<tr>
<td>Direct injection</td>
<td>• Create the Gradient Method for a Low-flow System</td>
<td>• Create the Gradient Method for Micro-Flow and High-Flow Systems</td>
</tr>
<tr>
<td>Trap-and-elute</td>
<td>• Create the Gradient Method for a Low-flow System</td>
<td>• Create the Gradient Method for Micro-Flow and High-Flow Systems</td>
</tr>
<tr>
<td></td>
<td>• Create the LC Method to Load the Trap Column for a Low-flow System</td>
<td>• Create the LC Method to Load the Trap Column for Micro-Flow and High-Flow Systems</td>
</tr>
</tbody>
</table>

For other LC methods, SCIEX recommends setting a minimum of 3% for mobile phase A.

### Create the Gradient Method for a Low-flow System

This method is used to separate the samples using the analytical column on a low-flow system.

1. Click **LC Methods** to display the LC Method Settings dialog.
2. In the **Name** field, type **Low-flow Gradient Method** and then click **Save**.
3. In the **Column Information** section, specify the values shown in the following figure.
4. Click the **Run Conditions** tab and specify the values shown in the following figure.
5. Click the **Gradient Table** tab and set the flow mode, the gradient parameters, and the flow rate shown in the following figure.

For most experiments, select **Conserved** for the **Flow Mode**. In Conserved mode, the system calculates the flow rate for each mobile phase based on the composition and total flow rate.
6. Click the **Gradient Profile** tab to view a graphical representation of the gradient.
The last two steps in the method allow for the weaker solvent to flow through the sample loop before the next sample is injected.

7. Click **Save**, then click **OK**.
Create the LC Method to Load the Trap Column for a Low-flow System

This method is used to load the sample onto the trap column.

1. In the Eksigent Control software Acquisition window, click the arrows to select Gradient 2 in the Channel section.
2. Click LC Methods to open the LC Method Settings dialog.
3. In the Name field, type Low-flow Trap Loading Method and then click Save.
4. In the Column Information section, type the values shown in the following figure.

Figure 3-22 Low-flow Trap Loading Method—Summary Tab
5. Click the **Run Conditions** tab and then type the values shown in the following figure.

**Figure 3-23 Low-flow Trap Loading Method—Run Conditions Tab**

6. Click the **Gradient Table** tab and then set the flow mode, the gradient parameters, and the flow rate as shown in the following figure.
Note: If there is carryover from one sample to the next, then add a step at the end of the method to wash the sample loop with the organic mobile phase.

7. At 1.5 min, click the Event cell and then select Start Gradient 1.

This event starts the Gradient 1 pump, which switches the trap column in-line with the analytical column. The sample will be eluted from the trap column onto the analytical column.

8. Click the Gradient Profile tab to view a graphical representation of the gradient.
Create the Gradient Method for Micro-Flow and High-Flow Systems

This method is used to separate the samples using the analytical column on a micro-flow or high-flow system.

1. Click LC Methods to display the LC Method Settings dialog.
2. In the Name field, type Gradient 1 Method and then click Save.
3. In the Column Information section, specify the values shown in the following figure.
4. Click the **Run Conditions** tab and specify the values shown in the following figure.
5. Click the **Gradient Table** tab and set the flow mode, the gradient parameters, and the flow rate shown in the following figure.

For most experiments, select **Conserved** for the **Flow Mode**. In Conserved mode, the system calculates the flow rate for each mobile phase based on the composition and total flow rate.
6. Click the **Gradient Profile** tab to view a graphical representation of the gradient.
The last two steps in the method allow for the weaker solvent to flow through the sample loop before the next sample is injected.

7. Click Save, then click OK.
Create the LC Method to Load the Trap Column for Micro-flow and High-Flow Systems

This method is used to load the sample onto the trap column on a micro-flow or high-flow system.

1. In the Eksigent Control software Acquisition window, click the arrows to select Gradient 2 in the Channel section.
2. Click LC Methods to open the LC Method Settings dialog.
3. In the Name field, type Trap Loading Method and then click Save.
4. In the Column Information section, type the values shown in the following figure.

Figure 3-30 Trap Loading Method—Summary Tab
5. Click the **Run Conditions** tab and then type the values shown in the following figure.

**Figure 3-31 Trap Loading Method—Run Conditions Tab**

6. Click the **Gradient Table** tab and then set the flow mode, the gradient parameters, and the flow rate shown in the following figure.
7. At 1.5 min, click the **Event** cell and then select **Start Gradient 1**.

This event starts the Gradient 1 pump, which switches the trap column in-line with the analytical column. The sample will be eluted from the trap column onto the analytical column.

8. Click the **Gradient Profile** tab to view a graphical representation of the gradient.
9. Click **Save** and then click **OK**.
Perform a Direct Injection Experiment

This section offers a brief tutorial on the use of the M5 MicroLC system to perform a direct injection experiment, using the Analyst® software. In a direct injection experiment, the sample is loaded into the injection loop and then injected directly on the analytical column.

In the example experiment that follows, a 5 µL sample loop with a full-loop injection is used. Refer to About Partial- and Full-loop Injections for information about partial-loop and full-loop injections.

Direct injection experiments can be performed with either an M5 MicroLC or an M5 MicroLC-TE system.

Note: The screen captures shown in this chapter are for the M5 MicroLC-TE system. For a M5 MicroLC system, the screens are slightly different.

Note: These instructions assume familiarity with the Analyst® software. For more information, refer to the Analyst™ Software Getting Started Guide or the System User Guide, available from the Customer Reference DVD.

Create the Direct Injection Acquisition Method

The acquisition method specifies the parameters for each device in the hardware profile.

1. On the Navigation bar, under Acquire, double-click Build Acquisition Method.
2. Click Acquisition Method in the left pane, and then set Synchronization Mode to LC Sync.
3. In the Acquisition Method Browser pane, click Mass Spec and then specify the appropriate parameters for the experiment.
4. Click Edit Parameters to set the Source/Gas parameters.

The parameters appropriate for micro LC are different than those that are appropriate for conventional liquid chromatography. Use the following values as a starting point and then determine optimal settings as necessary.

Note: Make sure to use the parameters appropriate for the flow rate configuration of the LC system in use.
Table 4-1 Source/Gas Parameters by System

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Low-flow M5 MicroLC System</th>
<th>Micro-flow or High-flow M5 MicroLC System</th>
</tr>
</thead>
<tbody>
<tr>
<td>Curtain Gas (CUR)</td>
<td>30 (or as optimized)</td>
<td>30 (or as optimized)</td>
</tr>
<tr>
<td>CAD Gas</td>
<td>Medium</td>
<td>Medium</td>
</tr>
<tr>
<td>IonSpray Voltage (IS) (V)</td>
<td>4500 (or as optimized)</td>
<td>4500 (or as optimized)</td>
</tr>
<tr>
<td>Temperature (TEM)</td>
<td>200 (or as optimized)</td>
<td>350 (or as optimized)</td>
</tr>
<tr>
<td>Ion Source Gas 1 (GS1)</td>
<td>15 (or as optimized)</td>
<td>25 (or as optimized)</td>
</tr>
<tr>
<td>Ion Source Gas 2 (GS2)</td>
<td>75 (or as optimized)</td>
<td>75 (or as optimized)</td>
</tr>
</tbody>
</table>

**Note:** For higher flow rates, the temperature (TEM) and ion source gas 1 (GS1) are typically higher.

**Tip!** Higher temperatures can lead to clogged electrodes on the mass spectrometer. As appropriate, use lower temperatures.

5. Click the **Compound** tab and then set the parameters as shown for the mass spectrometer.

Table 4-2 Suggested Compound Parameters by Mass Spectrometer

<table>
<thead>
<tr>
<th>Mass Spectrometer</th>
<th>Declustering Potential (DP)</th>
<th>Collision Energy (CE)</th>
</tr>
</thead>
<tbody>
<tr>
<td>SCIEX Triple Quad™ and QTRAP® systems</td>
<td>70</td>
<td>30</td>
</tr>
<tr>
<td>TripleTOF® systems</td>
<td>80</td>
<td>10</td>
</tr>
</tbody>
</table>

6. Click **OK** save the parameters.

7. Select the LC method for the Gradient 1 pump:
   a. In the Acquisition Method Browser pane, click **Gradient 1**.
   b. Browse to view the available LC methods.
   c. Click **Gradient 1 Method** and then click **Open**.

8. For an M5 MicroLC-TE system, right-click **Gradient 2** and then select **Use** to disable the Gradient 2 pump.
9. Click **File > Save**, and then type **Direct Inject Example Method** for the name of the method.

10. Select the autosampler script:

   a. In the **Analyst Device Driver** window, click **Method** to open the Instrument Control Method Editor window.
   
   b. Click **M5_Direct Inject** in the **Select Method Script** list.

   **Note:** The autosampler script installed with the system might have a different name than listed above. Use the most recent autosampler script supplied by SCIEX.

11. Set the parameters for the autosampler script in the **Parameter Setup** tab:

   **Tip!** Required fields are outlined in red. If a parameter is not visible in the software, then it might be in a panel that is closed. Click ☑️ to open a closed panel.

   a. In the **Tool** row, click **LCP 1**.
   
   b. In the **Pump Module** row, click **Pump 1**.
   
   c. In the **Cooled Stack 1** row, click **Peltier Stack 1**.
   
   d. In the **Injector** row, click **Injector LC1**.
   
   e. In the **Wash Station** row, click **LCMS Wash 1**.
   
   f. Click **File > Save to Analyst .dam file** and then select the previously-created acquisition method.
   
   g. Click **Yes** when prompted to overwrite the acquisition method and then close the Instrument Control Method Editor window.

12. Click **File > Save** to save the changes to the acquisition method.
Create the Acquisition Batch

1. On the Navigation bar, under Acquire, double-click Build Acquisition Batch.
2. Specify the required information on the Samples tab of the Batch Editor window.
3. Select the acquisition method created previously (Direct Injection Example Method).

Figure 4-2 Acquisition Section—Selecting the Acquisition Method

4. In the Plate Code column, select VT54 for all samples in the table.

"VT54" refers to the type of autosampler tray used for vials.

Figure 4-3 Sample Table—Selecting the Plate Code

<table>
<thead>
<tr>
<th>Sample Name</th>
<th>Rack Code</th>
<th>Rack Position</th>
<th>Plate Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blank001</td>
<td>Drawer</td>
<td>1</td>
<td>VT54</td>
</tr>
<tr>
<td>Blank002</td>
<td>Drawer</td>
<td>1</td>
<td>VT54</td>
</tr>
<tr>
<td>Blank003</td>
<td>Drawer</td>
<td>1</td>
<td>VT54</td>
</tr>
<tr>
<td>0.01 ng/mL triazine mix_1</td>
<td>Drawer</td>
<td>1</td>
<td>VT54</td>
</tr>
<tr>
<td>0.01 ng/mL triazine mix_2</td>
<td>Drawer</td>
<td>1</td>
<td>VT54</td>
</tr>
</tbody>
</table>

5. Scroll to the right side of the Sample Table and type 6 in the Inj. Volume (µl) field for all samples in the table.

Note: For other experiments, set the volume as appropriate, but the maximum volume must be less than 80 µL.

Figure 4-4 Sample Table—Injection Volume

<table>
<thead>
<tr>
<th>Vial Position</th>
<th>Data File</th>
<th>Inj.Volume (µl)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>System Integration Te</td>
<td>6</td>
</tr>
<tr>
<td>1</td>
<td>System Integration Te</td>
<td>6</td>
</tr>
<tr>
<td>1</td>
<td>System Integration Te</td>
<td>6</td>
</tr>
<tr>
<td>2</td>
<td>System Integration Te</td>
<td>6</td>
</tr>
<tr>
<td>2</td>
<td>System Integration Te</td>
<td>6</td>
</tr>
</tbody>
</table>
Submit the Batch

1. Put the sample vials in the appropriate positions in the cooled sample drawers.
2. Click the Submit tab of the Batch Acquisition dialog, and then click Submit to add the samples to the queue.
3. Click View > Sample Queue to open the Queue Manager (Local) dialog.
4. Click Acquire > Equilibrate to equilibrate the LC system and the mass spectrometer.
5. When the equilibration is finished, click Acquire > Start Sample to start the batch.

Monitor the Run

1. View the LC chromatogram and spectral data in Explore mode in the Analyst® software.
2. View flow rate and pressure information in the Acquisition window of the Eksigent Control software.

(M5 MicroLC-TE Systems Only) Direct Injection Using the Gradient 2 Pump

A low-flow or micro-flow M5 MicroLC-TE system can be used to perform a high-flow direct injection experiment using the Gradient 2 pump. Make the following changes:

• Plumb the valve for a direction injection experiment. Refer to Direct Injection Plumbing Diagram.
• Clear the Trap-Elute Mode check box in the Direct Control Dialog. Refer to Figure 3-9 in (M5 MicroLC-TE Systems Only) Verify the System Configuration.
• Plumb the G2 pump outlet to port 6 on the injection valve (instead of G1).
• Remove the MS interface cable from the I/O G1 port and connect it to the I/O G2 port.
• Create an LC method following the instructions in Create the LC Method to Load the Trap Column for a Low-flow System or Create the LC Method to Load the Trap Column for Micro-flow and High-Flow Systems, but delete the "Start Gradient 1" event.
• Select the autosampler script to be used in the acquisition method.
  1. In the Acquisition Method window, click Analyst Device Driver.
  2. In the Analyst Device Driver window, click Method to open the Instrument Control Method Editor window.
  3. In the Select Method Script list, click M5_TrapElute (or the most current version installed on the system). The method contains instructions required to operate the Gradient 2 pump, no matter what type of experiment is performed.

• In the Acquisition Method Browser pane, disable the Gradient 1 pump and enable the Gradient 2 pump.
Perform a Trap-and-Elute Experiment

This section offers a brief tutorial on the use of the M5 MicroLC-TE system to perform a trap-and-elute experiment using the Analyst® software. In a trap-and-elute experiment, the sample is loaded into the injection loop and then transferred to the trap column by one of the pumps. Sample components are concentrated onto the trap column, while any non-retained impurities like salts are washed away. After the sample loading has been completed, the trap column is switched in-line with the analytical column, and the gradient for the analysis is started.

In the example experiment that follows, a 50 µL sample loop with a full-loop injection is used. Refer to About Partial- and Full-loop Injections for information about partial-loop and full-loop injections.

Trap-and-elute experiments can only be performed with an M5 MicroLC-TE system.

Note: These instructions assume familiarity with the Analyst® software. For more information, refer to the Analyst™ Software Getting Started Guide or the System User Guide, available from the Customer Reference DVD.

Create the Trap-and-Elute Acquisition Method

The acquisition method specifies the parameters for each device in the hardware profile.

1. On the Navigation bar, under Acquire, double-click Build Acquisition Method.
2. Click Acquisition Method in the left pane, and then set Synchronization Mode to LC Sync.
3. In the Acquisition Method Browser pane, click Mass Spec and then specify the appropriate parameters for the experiment.
4. Click Edit Parameters to set the Source/Gas parameters.

The parameters appropriate for micro LC are different than those that are appropriate for conventional liquid chromatography. Use the following values as a starting point and then determine optimal settings as necessary.

Note: Make sure to use the parameters appropriate for the flow rate configuration of the LC system in use.
Table 5-1 Source/Gas Parameters by System

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Low-flow M5 MicroLC System</th>
<th>Micro-flow or High-flow M5 MicroLC System</th>
</tr>
</thead>
<tbody>
<tr>
<td>Curtain Gas (CUR)</td>
<td>30 (or as optimized)</td>
<td>30 (or as optimized)</td>
</tr>
<tr>
<td>CAD Gas</td>
<td>Medium</td>
<td>Medium</td>
</tr>
<tr>
<td>IonSpray Voltage (IS) (V)</td>
<td>4500 (or as optimized)</td>
<td>4500 (or as optimized)</td>
</tr>
<tr>
<td>Temperature (TEM)</td>
<td>200 (or as optimized)</td>
<td>350 (or as optimized)</td>
</tr>
<tr>
<td>Ion Source Gas 1 (GS1)</td>
<td>15 (or as optimized)</td>
<td>25 (or as optimized)</td>
</tr>
<tr>
<td>Ion Source Gas 2 (GS2)</td>
<td>75 (or as optimized)</td>
<td>75 (or as optimized)</td>
</tr>
</tbody>
</table>

**Note:** For higher flow rates, the temperature (TEM) and ion source gas 1 (GS1) are typically higher.

**Tip!** Higher temperatures can lead to clogged electrodes on the mass spectrometer. As appropriate, use lower temperatures.

5. Click the **Compound** tab and then set the parameters as shown for the mass spectrometer.

Table 5-2 Suggested Compound Parameters by Mass Spectrometer

<table>
<thead>
<tr>
<th>Mass Spectrometer</th>
<th>Declustering Potential (DP)</th>
<th>Collision Energy (CE)</th>
</tr>
</thead>
<tbody>
<tr>
<td>SCIEX Triple Quad™ and QTRAP® systems</td>
<td>70</td>
<td>30</td>
</tr>
<tr>
<td>TripleTOF® systems</td>
<td>80</td>
<td>10</td>
</tr>
</tbody>
</table>

6. Click **OK** save the parameters.

7. Select the LC method for the Gradient 1 pump:
   a. In the Acquisition Method Browser pane, click **Gradient 1**.
   b. Browse to view the available LC methods.
   c. Click **Gradient 1 Method** and then click **Open**.

8. Select the LC method for the Gradient 2 pump:
   a. In the Acquisition Method Browser pane, click **Gradient 2**.
   b. Browse to view the available LC methods.
   c. Click **Trap Loading Method** and then click **Open**.
Perform a Trap-and-Elute Experiment

9. Click File > Save, type Trap-and-Elute Example Method for the name of the method.

10. Select the autosampler script:
   a. In the Analyst Device Driver window, click Method to open the Instrument Control Method Editor window.
   b. Click M5_Direct Inject in the Select Method Script list.

   **Note:** The autosampler script installed with the system might have a different name than listed above. Use the most recent autosampler script supplied by SCIEX.

11. Set the parameters for the autosampler script in the Parameter Setup tab:

   **Tip!** Required fields are outlined in red. If a parameter is not visible in the software, then it might be in a panel that is closed. Click ☑ to open a closed panel.

   a. In the Tool row, click LCP 1.
   b. In the Pump Module row, click Pump 1.
   c. In the Cooled Stack 1 row, click Peltier Stack 1.
   d. In the Injector row, click Injector LC1.
   e. In the Wash Station row, click LCMS Wash 1.
   f. Click File > Save to Analyst .dam file and then select the previously-created acquisition method.
   g. Click Yes when prompted to overwrite the acquisition method and then close the Instrument Control Method Editor window.

12. Click File > Save to save the changes to the acquisition method.

Create the Acquisition Batch

1. On the Navigation bar, under Acquire, double-click Build Acquisition Batch.
2. Specify the required information on the Samples tab of the Batch Editor window.
3. Select the acquisition method created previously (Trap Elute Example Method).
Figure 5-1 Acquisition Section—Selecting the Acquisition Method

4. In the **Plate Code** column, select **VT54** for all samples in the table.

"VT54" refers to the type of autosampler tray used for vials.

Figure 5-2 Sample Table—Selecting the Plate Code

<table>
<thead>
<tr>
<th>Sample Name</th>
<th>Rack Code</th>
<th>Rack Position</th>
<th>Plate Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blank001</td>
<td>Drawer</td>
<td>1</td>
<td>VT54</td>
</tr>
<tr>
<td>Blank002</td>
<td>Drawer</td>
<td>1</td>
<td>VT54</td>
</tr>
<tr>
<td>Blank003</td>
<td>Drawer</td>
<td>1</td>
<td>VT54</td>
</tr>
<tr>
<td>0.01 ng/mL triazine mix.1</td>
<td>Drawer</td>
<td>1</td>
<td>VT54</td>
</tr>
<tr>
<td>0.01 ng/mL triazine mix.2</td>
<td>Drawer</td>
<td>1</td>
<td>VT54</td>
</tr>
</tbody>
</table>

5. Scroll to the right side of the **Sample Table** and type **60** in the **Inj. Volume (µl)** field for all samples in the table.

**Note:** For other experiments, set the volume as appropriate, but the maximum volume must be less than 80 µL.

Figure 5-3 Sample Table—Injection Volume

<table>
<thead>
<tr>
<th>Vial Position</th>
<th>Data File</th>
<th>Inj. Volume (µl)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>System Integration Te</td>
<td>60</td>
</tr>
<tr>
<td>1</td>
<td>System Integration Te</td>
<td>60</td>
</tr>
<tr>
<td>1</td>
<td>System Integration Te</td>
<td>60</td>
</tr>
<tr>
<td>2</td>
<td>System Integration Te</td>
<td>60</td>
</tr>
<tr>
<td>2</td>
<td>System Integration Te</td>
<td>60</td>
</tr>
</tbody>
</table>

Submit the Batch

1. Put the sample vials in the appropriate positions in the cooled sample drawers.
2. Click the **Submit** tab of the Batch Acquisition dialog, and then click **Submit** to add the samples to the queue.
3. Click **View > Sample Queue** to open the Queue Manager (Local) dialog.
Perform a Trap-and-Elute Experiment

4. Click Acquire > Equilibrate to equilibrate the LC system and the mass spectrometer.
5. When the equilibration is finished, click Acquire > Start Sample to start the batch.

Monitor the Run

1. View the LC chromatogram and spectral data in Explore mode in the Analyst® software.
2. View flow rate and pressure information in the Acquisition window of the Eksigent Control software.
Routine Maintenance

This chapter describes procedures to maintain the M5 MicroLC system.

**WARNING!** Ionizing Radiation Hazard, Biohazard, or Toxic Chemical Hazard. Determine whether decontamination is required prior to cleaning or maintenance. The customer must decontaminate the system prior to cleaning or maintenance if radioactive materials, biological agents, or toxic chemicals have been used with the system.

**Maintenance Schedule**

Perform the following procedures at the specified interval.

**Table 6-1 Routine Maintenance**

<table>
<thead>
<tr>
<th>Procedure</th>
<th>Frequency</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dispose of Waste</td>
<td>As needed</td>
</tr>
<tr>
<td>Replace the Autosampler Wash Solvents and Load the Mobile Phases</td>
<td>As needed</td>
</tr>
<tr>
<td>If the system is idle for more than a week, Purge the Mobile Phases and Flush the System</td>
<td>As needed</td>
</tr>
<tr>
<td>Clean the Surfaces</td>
<td>As needed</td>
</tr>
<tr>
<td>Replace the Syringe Needle</td>
<td>As needed</td>
</tr>
<tr>
<td>Inspect the System</td>
<td>Weekly</td>
</tr>
<tr>
<td>Re-initialize the Pressure Transducers</td>
<td>Weekly</td>
</tr>
<tr>
<td>Replace the Pump Seal Rinse</td>
<td>Quarterly</td>
</tr>
<tr>
<td>Replace the Syringe Barrel and Plunger (replace the syringe barrel as needed, and the plunger yearly)</td>
<td>Yearly</td>
</tr>
<tr>
<td>Replace the Valve Rotor Seal</td>
<td>Yearly (or as needed)</td>
</tr>
<tr>
<td>Replace the Injection Port</td>
<td>Yearly (or as needed)</td>
</tr>
</tbody>
</table>
Routine Maintenance

Inspect the System

1. Inspect all solvent reservoirs for evidence of biological growth or precipitation.

   If present, replace the solvent and filter, then purge the mobile phases. Refer to Purge the Mobile Phases and Flush the System.

2. Visually inspect the system tubing and fittings.

   Look for broken fittings and dried deposits that might indicate a slow leak.
   a. Tighten any loose connections.
   b. If a fluidic connection is broken, replace the fitting and then flush the system. Refer to Purge the Mobile Phases and Flush the System.

Dispose of Waste

Properly dispose of the contents of any effluent waste in an appropriate chemical waste container. After disposing of the waste liquid, make sure that the waste tubing has no loops and that it is located so that the end of the tubing will not be submerged in the waste liquid.

WARNING! Biohazard, Toxic Chemical Hazard. Follow local directives when disposing of chemicals and the remains of the prepared samples, if applicable. They might contain regulated compounds and biohazardous agents.

Clean the Surfaces

Clean the external surfaces of the system after a spill or when they become dirty.

<table>
<thead>
<tr>
<th>Required Materials</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Soft rags</td>
</tr>
</tbody>
</table>

1. Wipe the surfaces of the system with a soft, damp, cloth.

2. Dry with a dry rag.
Maintenance Procedures for the Pumps

Re-initialize the Pressure Transducers

**CAUTION:** Potential System Damage. Open the pump outlet to make sure that there is no residual pressure on the outlet of the pump before initializing the pressure transducers. Attempting to initialize the pressure transducers while there is still residual pressure leads to inaccurate flow rates and possibly damage to the LC system.

1. Stop the system flow.
2. Loosen the fittings in the pump outlets on the valve panel to release all of the residual pressure.
3. Click **System > Hardware Diagnostics**.
4. On the **Flow Calibration** tab, click **Re-Initialize Transducers**.

![Figure 6-1 Hardware Diagnostics Dialog—Flow Calibration Tab](image)
5. For M5 MicroLC-TE systems, a message appears asking if the calibration should be performed for both channels. Click Yes. A warning appears that this procedure should only be performed if there is no residual pressure on the pump.

6. Make sure that the pump outlets are open, and then click OK.

   A status dialog indicates that the re-initialization is in progress.

7. When the system shows a message that the transducers are re-initialized, click OK.

8. Click Close to exit the Hardware Diagnostics dialog and then return to the Acquisition window.

Replace the Pump Seal Rinse

<table>
<thead>
<tr>
<th>Required Materials</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Alcohol such as methanol, ethanol, or propanol</td>
</tr>
</tbody>
</table>

• As necessary, discard the pump seal rinse (in the bottle with the green tubing) and then replace it with new solvents.

   Use a 1:1 mixture of water and a common alcohol such as methanol, ethanol, or propanol and fill the bottle 2/3 full.

Purge the Mobile Phases and Flush the System

After changing the mobile phase bottles or if the system has been idle for a week or more, purge the old mobile phases from the system.

<table>
<thead>
<tr>
<th>Required Materials</th>
</tr>
</thead>
<tbody>
<tr>
<td>• 1/32 inch o.d. tubing</td>
</tr>
</tbody>
</table>

1. Make sure that the column is not connected.

2. Connect one end of a length of 1/32 inch o.d. tubing to the mobile phase outlet on the front of the pump and insert the other end into the waste.

3. In the Eksigent Control software, click System > Mobile Phases, and then click More to display additional options in the dialog.

4. Purge the mobile phases.

   a. In the Purge Settings section, select the Side A or Side B, or both, check box as appropriate.

   b. (Optional) For the M5 MicroLC-TE system, select Apply to all channels to purge both channels at once.

   c. Type a minimum of 20 in the purge cycles field.
d. Click **Purge Now** and wait until all purge cycles have completed.

**Figure 6-2 Mobile Phase Dialog—Settings for Purging**

5. Flush the system.
   a. In the **Flush Settings** section, type **100 µL** for the **Total Volume**.
   b. Set the **Flush Flowrate** based on the system configuration:
      - For a low-flow system, type **10 µL/min**.
      - For a micro-flow or high-flow system, type **50 µL/min**.
   c. (Optional) For the M5 MicroLC-TE system, select **Apply to all channels** to flush both channels at once.

   **CAUTION: Potential System Damage:** Make sure that the LC column is not connected before proceeding with this operation. Flushing the system with a column connected could over-pressure the system and create leaks.

   d. Click **Flush Now**.

**Figure 6-3 Mobile Phase Dialog—Settings for Flushing for Micro-flow and High-flow Systems**

The system flushes 100 µL through the system.
6. Click OK.
7. Remove the tubing from the pump outlet and then reconnect the column.

**Measure the Flow Rate**

<table>
<thead>
<tr>
<th>Required Materials</th>
</tr>
</thead>
<tbody>
<tr>
<td>The appropriate calibration kit for the system.</td>
</tr>
<tr>
<td>For the low-flow M5 MicroLC-TE system, both calibration kits are required.</td>
</tr>
<tr>
<td>For any other system, use the appropriate kit for the flow rate of the system.</td>
</tr>
<tr>
<td>External timer</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>System Configuration</th>
<th>Calibration Pipette Volume</th>
<th>Calibration Flow Rate</th>
</tr>
</thead>
<tbody>
<tr>
<td>Low-flow (1 µL/min to 10 µL/min)</td>
<td>20 µL</td>
<td>5 µL/min</td>
</tr>
<tr>
<td>Micro-flow (5 µL/min to 50 µL/min)</td>
<td>100 µL</td>
<td>25 µL/min</td>
</tr>
<tr>
<td>High-flow (20 µL/min to 200 µL/min)</td>
<td>200 µL</td>
<td>100 µL/min</td>
</tr>
</tbody>
</table>

1. Connect the flow calibration pipette to the pump using the 25 µm i.d. PEEK-clad fused silica tubing.
   a. Disconnect the tubing from the pump outlet.
   b. Connect the 25 µm i.d. PEEK-clad fused silica tubing to the pump.
   c. Select the appropriate pipette for the system configuration from Table 6-2.
   d. Insert the free end of the 25 µm i.d. PEEK-clad fused silica tubing in the silicon tubing on the calibration pipette.

2. Measure the time to fill the pipette with the volume specified in Table 6-2.
   a. In the Direct Control dialog, select the **Conserved Flow** option.
   b. Set the mobile phase composition to **50 A** and **50 B**.
   c. Set the **Total flowrate** as specified in Table 6-2.
   d. Click **Start**.
   The expected time varies by system configuration:
   - For the low-flow configuration, the expected time is 240 seconds. A range of 230 to 240 seconds is required.
   - For the micro-flow configuration, the expected time is 240 seconds. A range of 230 to 250 seconds is required.
• For the high-flow configuration, the expected time is 120 seconds. A range of 115 to 125 seconds is required.

3. Do one of the following:

• If the flow is within the acceptable range, then the flowmeters do not need calibration. Disconnect the 25 µm i.d. PEEK-clad fused silica tubing and then reconnect the original tubing between the pump and the injection valve.

• If the flow is outside of the acceptable range, then Calibrate the Flowmeters.

Calibrate the Flowmeters

<table>
<thead>
<tr>
<th>Required Materials</th>
</tr>
</thead>
<tbody>
<tr>
<td>• The appropriate calibration kit for the system.</td>
</tr>
<tr>
<td>• For the low-flow M5 MicroLC-TE system, both calibration kits are required.</td>
</tr>
<tr>
<td>• For any other system, use the appropriate kit for the flow rate of the system.</td>
</tr>
</tbody>
</table>

1. If necessary, connect the flow calibration assembly to the pump using the 25 µm i.d. tubing.
2. Click **System > Hardware Diagnostics**.
3. Click **Calibrate Flowmeter** to open the Flowmeter Calibration wizard.

![Figure 6-4 Flowmeter Calibration Wizard–Step 1](image)

4. In the **Step 1** section, verify that the mobile phases are correct and then click **Next**.

   If the mobile phases are not correct, click **Cancel** and then make the necessary changes in the Mobile Phases dialog. Refer to **Load the Mobile Phases**.

5. In the **Step 2** section, set the pipette size.

   • For a low-flow system, select **20 µL/division**.
For a micro-flow system, select 100 µL/division.

For a high-flow system, select 200 µL/division.

**Figure 6-5 Set the Flowmeter Calibration Size—High-flow System**

6. Click **Next** to start the flow in side A.

7. In the **Step 3** section, specify the appropriate **Volume**.
   
   - For a low-flow system, type **20**.
   - For a micro-flow system, type **100**.
   - For a high-flow system, type **200**.

**Figure 6-6 Set the Flowmeter Calibration Volume—High-flow System**

8. Bring the meniscus to the black line on the pipette and then click **Start** to begin timing.

**Figure 6-7 Calibration Pipette, Meniscus Before (Top) and At (Bottom) Black Line (Arrow Indicates Direction of Flow)**

9. When the fluid reaches the end of the pipette, click **Stop**.

10. Click **Next** and then repeat the procedure to calibrate the side B flowmeter.
11. Click Finish.

12. Do one of the following:

- If the calibration passed, then repeat Measure the Flow Rate to determine whether the flow rate is within acceptable bounds.
- If the calibration failed, then inspect for leaks, make sure that the settings in the Mobile Phases dialog are correct for the solvents in use, and then purge and flush the system. Repeat the calibration. If the calibration fails again, contact SCIEX Technical Support at sciex.com/request-support.

13. For an M5 MicroLC-TE system, repeat the calibration for Gradient 2.
   a. Close the Flowmeter Calibration dialog.
   b. In the Hardware Diagnostics dialog, click the arrows in the upper-right corner to select Gradient 2.
   c. Click Calibrate Flowmeter Ch 2 to repeat the calibration.
   d. In the Step 2 section, select 200 µL/division for the pipette size.
   e. In the Step 3 section, type 200 in the Volume field.

14. Disconnect the 25 µm i.d. tubing and then connect the original tubing between the pump and the injection valve.

### Maintenance Procedures for the Valve

#### Replace the Injection Port

<table>
<thead>
<tr>
<th>Required Materials</th>
</tr>
</thead>
<tbody>
<tr>
<td>Injection port</td>
</tr>
</tbody>
</table>

1. Remove the injection port from port 3 on the valve.
2. Put the port in port 3 on the injection valve and then tighten it until it is finger-tight.
Replace the Sample Loop

The sample loop is located between ports 1 and 4 on the injection valve. Change the sample loop to inject a different sample volume or if a clog is present in the loop.

**Required Materials**

- Sample loop
- Wrench for 1/32 inch and 1/16 inch nuts (in the system accessory kit)
- 2 nuts
- 2 ferrules

1. Remove the loop.
2. Connect the new loop to port 1 on the injection valve using the wrench and one of the ferrules.
3. Connect the other end of the loop to port 4 with the other nut and ferrule.

Replace the Valve Rotor Seal

Replace the valve rotor seal if the valve leaks.

**Required Materials**

- Long Phillips screwdriver
- Wrench for 1/32 inch and 1/16 inch nuts (in the system accessory kit)
- 9/64 inch hex key
- T20 Torx driver
- Injection valve rotor seal

1. Close the Eksigent Control software.
2. Using the switch on the back of the system, turn off the power to the system and then disconnect the mains supply cable.

3. Remove the valve from the system:
   a. Remove the sample loop and any tubing connected to the injection valve, using the wrench as necessary.
   b. Remove the top valve cover by lifting it and then moving it horizontally out of the back slots.
   c. Using a T20 Torx driver, remove the two screws on the front valve cover and remove it.
   d. From underneath the valve, loosen the two captive screws on the valve bracket.

   Figure 6-10 Valve Mounting—Captive Screws in Red

   e. Carefully move the valve down, out of the spill basin, and then disconnect the electrical cable. Make a note of where the cable connects.

4. Remove the valve stator.
   a. Use the 9/64 inch hex key to remove the three hex screws from the top of the valve stator.
   b. Lift off the stator and then set it aside.
5. Remove the rotor seal.
   
a. (Optional) Lift off the black plastic alignment cylinder and then set it aside.

b. Lift the rotor seal out of the valve.

The rotor seal consists of a black disk in a silver case.

**Note:** It might be possible to lift the rotor seal without removing the alignment cylinder.
Figure 6-12 Injection Valve—Top View, With Stator Removed

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Rotor seal</td>
</tr>
<tr>
<td>2</td>
<td>Alignment cylinder</td>
</tr>
</tbody>
</table>

6. Install the new rotor seal.
   a. Put the new rotor seal on the valve, seating it on the three pins.
   b. Install the black plastic alignment cylinder on the valve, rotating as necessary to seat it.
   c. Install the stator and then tighten the hex screws.

7. Install the valve.
   a. Connect the electrical cable.
   b. Put the valve back in the spill basin.
   c. Tighten the captive screws on the valve bracket.
   d. Install the front valve cover and then tighten the screws.
   e. Insert the top valve cover in the back slots.

8. Plumb the injection valve.

9. Connect the mains supply cable and, using the switch on the back of the system, turn on the power.

10. Press the power switch on the front of the system to turn on the system.
Replace the Valve Pod

**Required Materials**

- Long Phillips screwdriver
- Wrench for 1/32 inch and 1/16 inch nuts (in the system accessory kit)
- T20 Torx driver
- Injection valve pod

1. Close the Eksigent Control software.
2. Using the switch on the back of the system, turn off the power to the system and then disconnect the mains supply cable.
3. Remove the valve from the system:
   a. Remove the sample loop and any tubing connected to the injection valve, using the wrench as necessary.
   b. Remove the top valve cover by lifting it and then moving it horizontally out of the back slots.
   c. Using a T20 Torx driver, remove the two screws on the front valve cover and remove it.
   d. From underneath the valve, loosen the two captive screws on the valve bracket.
   e. Carefully move the valve down, out of the spill basin, and then disconnect the electrical cable. Make a note of where the cable connects.

*Figure 6-13 Valve Mounting—Captive Screws in Red*
4. Remove the pod from the actuator.
   a. Rotate the black ribbed retaining nut that holds the pod in the actuator to loosen it.
      Do not use a wrench. The retaining nut should only be tightened and loosened by hand.
   b. Pull the pod from the actuator.

5. Install the pod.
   a. Insert the new pod into the actuator.
      The pod union will make contact with the spline in the actuator.
   b. Press lightly and rotate the pod until the pod moves further into the actuator and the pin contacts the actuator.
   c. Continue to rotate the pod until the pin is seated in the notch in the actuator, and then push it in. Refer to Figure 6-14.
   d. Install the retaining nut and tighten it by hand.

**Figure 6-14 Valve Pod–Side View, Showing Pin in Notch**

6. Install the valve.
   a. Connect the electrical cable.
   b. Put the valve back in the spill basin
   c. Tighten the captive screws on the valve bracket.
   d. Install the front valve cover and then tighten the screws.
   e. Insert the top valve cover in the back slots.
Routine Maintenance

7. Plumb the injection valve.
8. Connect the mains supply cable and, using the switch on the back of the system, turn on the power.
9. Press the power switch on the front of the system to turn on the system.

Maintenance Procedures for the Autosampler

Replace the Autosampler Wash Solvents

1. Refill the aqueous wash solvent in the 1 L glass bottle. The aqueous solvent is typically water with 0.1% formic acid.
   Make sure that the solvent tubing labeled W1 is attached to the Wash 1 pump and the other end is in the glass bottle.
2. Refill the organic wash solvent in the 1 L glass bottle. The organic solvent is typically acetonitrile (or other organic solvent) with 0.1% formic acid.
   Make sure that the solvent tubing labeled W2 is attached to the Wash 2 pump and the other end is in the glass bottle.
3. After replacing the wash solvents, prime the LCMS tool pumps. Refer to Prime the LCMS Tool Wash Solvent Tubing.

Replace the LCMS Tool Wash Solvent Tubing

**CAUTION: Potential Operator Injury. To avoid the possibility of exposure to solvents, be sure to wear gloves.**

<table>
<thead>
<tr>
<th>Required Materials</th>
</tr>
</thead>
<tbody>
<tr>
<td>• LCMS tool tubing kit</td>
</tr>
<tr>
<td>• T6 Torx driver</td>
</tr>
</tbody>
</table>

1. Remove the LCMS tool wash solvent tubing from the system.
a. Disconnect the tubing from the LCMS tool pumps on the back of the system and then pull up on the guide wire to remove the barrel from the bracket.

**Figure 6-15 Location for LCMS Tool Guide Wire—Back of System**

b. Disconnect the tubing from the LCMS tool on the front of the system.

c. Using the T6 Torx driver, loosen (but do not remove) the set screw holding the guide wire and then lift the solvent tubing away from the system.

**Figure 6-16 Location of LCMS Tool Guide Wire—Front of System**

2. Reverse step 1 to connect the guide wire and wash solvent tubing. Tighten the fittings until they are finger-tight.

3. Prime the wash solvent tubing. Refer to Prime the LCMS Tool Wash Solvent Tubing.
Prime the LCMS Tool Wash Solvent Tubing

1. Start the PAL Virtual Terminal software and make sure that Access level is set to Extended User. Refer to Change the Access Mode to Extended User Level.
2. Click LCP1.
3. Select Options > Prime LC-Tool.
4. Click Filling Stroke and set the number of strokes to 10.
   
   **Tip!** If the wash solvent containers are far from the system, then increase the number of strokes.

5. Click Washsource and select 1.
6. Start the priming. Watch the tubing and make sure that liquid is pulled through the tubing.
7. If necessary, repeat the steps until the liquid is flowing through the tubing.
   
   **Tip!** Alternatively, remove the check valve from the LCMS tool pump, connect the tubing directly to the pump, and then prime the pump. When liquid is flowing, install the check valve, connect the tubing, and then prime the pump again.

8. Repeat for the other solvent tubing, selecting 2 for the Washsource.

Replace the LCMS Tool Pump Module

**CAUTION: Potential Operator Injury.** To avoid the possibility of exposure to solvents, be sure to wear gloves.

**Required Materials**

- LCMS tool pump module
- T20 Torx driver
- Gloves

1. Press the power switch on the front of the system to turn off the system.
2. (Optional) If the solvent tray is installed on the same side of the system as the LCMS tool pump module, then remove it for better access to the pump.
3. Remove the tubing from the back of the system.
   a. Disconnect the tubing from the top of the pump module on the back of the system.
b. Remove the check valves.

c. Pull the tubing from the wash solvent bottles up, out of the solvent, to prevent additional solvent from filling the tubing, and then disconnect the tubing from the bottom of the pump module.

d. Put the ends of the tubing up so that the solvent does not drain out.

4. Remove the pump module.

a. Using the T20 Torx driver, remove the screws at the top of the pump module.

b. Pull the pumps away from the system and then disconnect the cable from the back of the pump module.

c. Disconnect the cable from the back of the system. Gently pull the cable away so that it does not fall inside the case.

5. Reverse steps 4 and 3 to replace the pump module and the check valves and then attach the tubing.

Make sure to match the number on the tubing to the number on the pump.

6. Press the power switch on the front of the system to turn on the system.

Configure the LCMS Tool Pumps

The LCMS Tool pump module has an ID that is saved in the CTC PAL 3 autosampler firmware. If the pump module is replaced, then the new ID will not match the existing ID in the firmware and the autosampler must be configured to use the new pump module.

1. Start the PAL Virtual Terminal software and make sure that **Access level** is set to **Extended User**. Refer to Change the Access Mode to Extended User Level.

   The status indicator in the upper right corner is yellow, indicating a problem with the autosampler.
2. In the PAL Virtual Terminal software, replace the old pump with the new pump and then rename it.
   a. Click **Options > Pending Message**.
b. Click OK in the message.

c. In step 1, click **Replace Pump 1** and then press **Enter**.

d. In step 2, click **OK** to replace the old pump with the new pump.

e. Click **LCP1** and then click the arrow button to scroll to PumpModule.
Routine Maintenance

f. Double-click **PumpModule** and then click **Pump 1**.

**Figure 6-19 Rename the Pump**

![Image of PumpModule interface]

- Click **Back**.
- Click **OK** in the message to restart the autosampler.

**Figure 6-20 Restart Message**

![Message for restarting the autosampler]

The PAL Virtual Terminal software closes and the CTC PAL 3 autosampler power cycles.

3. In the Analyst® software, deactivate the hardware profile.
4. Using the Analyst® Device Driver, retrieve the autosampler configuration. Refer to step 7 in Install the CTC PAL 3 Driver and Configure the Device.
5. Prime the wash solvent tubing. Refer to Prime the LCMS Tool Wash Solvent Tubing.
6. Activate the hardware profile in the Analyst® software and then update the acquisition methods. For each method:
   a. In the Acquisition Method window, double-click Analyst Device Driver.
   b. In the Analyst Device Driver window, click Method to open the Instrument Control Method Editor window.
   c. Click File > Open from Analyst.dam file and then select an acquisition method.
   d. Click Save.
7. After all the methods have been updated, click File > Exit to close the Instrument Control Method Editor window.

Set the Temperature of the Sample Drawers

1. Start the PAL Virtual Terminal software and make sure that Access level is set to Extended User. Refer to Change the Access Mode to Extended User Level.
2. Click Peltier Stack 1 and then click Options > Activate Standby Temperature.

Figure 6-21 Selecting Activate Standby Temperature
3. Click the black arrow to scroll the list of parameters until **Stdby Temperature** is shown. Double-click **Stdby Temperature**, press the up and down arrow keys to change the temperature, and then press **Enter** to save the changes.

**Figure 6-22 Peltier Stack 1 Parameters**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Actual Temp</td>
<td>8.1 °C</td>
</tr>
<tr>
<td>Max Temperature</td>
<td>40.0 °C</td>
</tr>
<tr>
<td>Min Temperature</td>
<td>4.0 °C</td>
</tr>
<tr>
<td>Stdby Temp Contr</td>
<td>On</td>
</tr>
<tr>
<td>Stdby Temperature</td>
<td>8.0 °C</td>
</tr>
</tbody>
</table>

Range is: 4.0 °C ... 40.0 °C

4. Click **Back** and then click **X** to close the Remote Terminal window.

**Replace the Syringe Needle**

![WARNING! Puncture Hazard. Handle the needle with care. The tip of the needle is extremely sharp.]

1. Move the Z-arm to a location with better access to the LCMS tool.
   a. Start the PAL Virtual Terminal software and make sure that **Access level** is set to **Extended User**. Refer to **Change the Access Mode to Extended User Level**.
   b. Click **LCP1 > Options > Change Syringe**.
   c. Click **Move**.

The Z-arm moves down and away from the system.
2. Remove the syringe needle.
   a. Loosen the needle collar and then move the needle down. Make sure that the PTFE seal is attached to the needle.
   b. Holding the needle with one hand, push the lower needle guide up with the other hand.
   c. Tilt the needle to the side so it can be removed from the needle guides.
   d. Put the needle collar and the washer in a safe place.

3. Prepare the needle.
   a. Insert the needle in the PTFE seal.

Sometimes the hole in the seal contains a burr (PTFE residue from the seal), shown in the following figure.

Figure 6-23 PTFE Needle Seal—Clean (Left) and with Burr (Right)
Routine Maintenance

b. If necessary, remove any burrs.

Remove the seal from the needle and then use the long end of the needle to push the burr out. Refer to Figure 6-24.
Be careful not to scratch the seal.

Figure 6-24 Cleaning the PTFE Needle Seal

4. Install the needle.

a. Push the clear safety shield on the Z-arm up to allow access to the syringe.

b. With one hand, lift the bottom needle guide until it touches the upper needle guide.

c. With the other hand, guide the tip of the new needle in both guides and then release the lower needle guide.

d. Insert the top of the needle in the fitting and then tighten the needle collar until it is finger-tight.
5. Gently move the needle guides up and down to make sure that the tip of the needle is near the bottom of the hole in the needle guide.

If the needle guide is above the hole at rest, then the needle will probably hit the hole when compressed, bending the needle.
Replace the Syringe Barrel and Plunger

Use this procedure to replace the syringe barrel, plunger, or both.

**Required Materials**

- Syringe barrel
- Syringe plunger

**WARNING!** Puncture Hazard. Handle the needle with care. The tip of the needle is extremely sharp.

1. Move the Z-arm to a location with better access to the LCMS tool.
   a. Start the PAL Virtual Terminal software and make sure that Access level is set to Extended User. Refer to Change the Access Mode to Extended User Level.
   b. Click LCP1 > Options > Change Syringe.
   c. Click Move.

2. Remove the LCMS tool from the Z-arm.
   a. Remove the syringe needle from the syringe. Be careful not to lose the washer.
b. Using a T6 Torx driver, loosen the set screw from the metal arm until the wire can be pulled free.

**Tip!** After removing the wire, tighten the set screw to prevent it from getting lost.

Figure 6-28 Location for Guide Wire—Front of System

![Figure 6-28 Location for Guide Wire—Front of System](image)

c. Disconnect the tubing from the front of the tool.

Figure 6-29 LCMS Tool Tubing—Front of System

![Figure 6-29 LCMS Tool Tubing—Front of System](image)

d. Lift the silver latch on the plunger coupling adapter to free the plunger.
Routine Maintenance

e. Hold the bottom of the LCMS tool with one hand and then pull the black latch to the right with other hand until the tool is free from the Z-arm.

3. Remove the syringe barrel.
   a. Turn the black ribbed nut at the top of the LCMS tool to loosen it and then pull the nut and the plunger away from the tool.
   b. Turn the metal nut at the bottom of the syringe barrel to loosen it and then lift the barrel out of the tool.

4. Install the syringe barrel and plunger in the LCMS tool.
   a. Insert the plunger in hole in the ribbed nut and then in the syringe.
   b. Put the syringe through the hole in the top of the LCMS tool.
   c. Align the hole in the syringe barrel with the hole in the bottom of the LCMS tool and tighten the metal retaining nut.
   d. At the top of the LCMS tool, tighten the retaining nut to secure the mechanical stop. Do not overtighten.

5. Install the LCMS tool on the Z-arm.
   a. Turn the LCMS tool so that the black portion is facing away from the system.

   **Figure 6-30 LCMS Tool—Top View**

   b. Align the three cylinders on the top of the LCMS tool with the holes in the Z-arm platform and then move the tool up until the cylinders protrude from the upper side of the Z-arm platform.
c. Hold the tool in place with one hand, push the black latch to the right with the other, and then release it.

Figure 6-31 LCMS Tool Latch

6. Connect the syringe plunger to the LCMS tool.
   a. Pull the plunger partially up from the black retaining nut.
   b. Lower the plunger coupling adapter and the plunger coupling block over the syringe plunger until it clicks.
Figure 6-32 LCMS Tool—Plunger Coupling Adapter

7. Connect the guide wire and the tubing to the front of the system.

8. Tilt the syringe needle to insert the needle tip in the lower needle guide, then move the needle back and up to the needle holder and tighten it firmly.

9. In the Remote Terminal window, click **Next** to move the Z-arm to the original position.

10. Prime the wash solvent tubing. Refer to Prime the LCMS Tool Wash Solvent Tubing.

(Optional) Set Up the Autosampler to Use Microtiter Plates

By default, the system is configured to use VT54 vial plates. The system can also use 96- or 384-well plates.

1. Remove the VT54 plates from both slots in drawer 1 and then replace them with empty microtiter plates.

2. Retrieve the autosampler configuration in Analyst Device Driver.
   a. Make sure that the hardware profile is deactivated.
b. On the Navigation bar, under **Companion Software**, double-click **Analyst Device Driver**.

**Figure 6-33 Analyst Device Driver**

![Analyst Device Driver](image1)

b. In the Analyst Device Driver window, click **Configure**.

**Figure 6-34 LC Device Configuration Dialog with the CTC PAL3 Autosampler Selected**

![LC Device Configuration Dialog](image2)
d. Click **Retrieve Configuration**.

![Figure 6-35 Configure CTC PAL3 LC Sampler Dialog with Configuration Retrieved](image)

3. Click **Tray Configuration** to open the Tray Configuration dialog.
4. Click the upper list and select the type of plate or rack. Do not change the lower list.
   - **MTP96** for a 96-well plate
   - **MTP384** for a 384-well plate
   - **DPW96** for a deep-well 96-well plate

5. As necessary, change the plate or tray in slot 2 in Drawer 1.
6. As necessary, make changes to Drawers 2 and 3.
7. Click OK to close the Tray Configuration dialog.

   Analyst® Device Driver retrieves the configuration from the autosampler.

8. Click OK to close the Configure CTC PAL3 LC Sampler dialog and then click OK to close the LC Device Configuration dialog.

9. In the Analyst® software, activate the hardware profile.

**Change the Access Mode to Extended User Level**

By default, the PAL 3 starts in User Level access mode. The procedures in this guide require that the system be in Extended User Level access mode.

1. On the keyboard, press A and B simultaneously.

   **Figure 6-37 Change Access Screen**

   ![Change Access Screen](image)

   The asterisk indicates that the access mode is set to **User Level**.

2. Select **Extended User Level** and then press **Enter**.

   **Note:** The key icon ![key_icon] indicates the system is in Extended User Level access mode.
**Note:** If the Remote Terminal window is inactive for 60 minutes, then the software automatically reverts to User Level access mode.

---

**Figure 6-38 Extended Access Level**

![Extended Access Level](image)

---

**Complete the CTC PAL 3 Installation Wizard**

**CAUTION:** Potential System Damage. Be sure to perform all of the steps in the Installation Wizard. The PAL drives and tools must all be calibrated before operation of the system.

1. Turn on the M5 MicroLC system.
2. Remove any racks from the first sample drawer.
3. Start the PAL Virtual Terminal software and make sure that **Access level** is set to **Extended User**. Refer to Change the Access Mode to Extended User Level.
4. Click **Options > Service > Installation**.
5. Follow the instructions in the Remote Terminal window to perform each step of the installation wizard. The Setup Network step is not available and does not need to be performed.

- To edit a number, press the up and down arrow keys and then press **Enter**. To scroll quickly, hold down the arrow key. To save the value, double-click the field.

- To edit text, press **Enter** and then use the up and down arrows to scroll through the alphabet. Press **Enter** to select the letter. To save the value, double-click the field.
6. At the **Set Homing Strategy** step, accept the default parameters.

7. At the **Teach Exchange Position** step, manually move the Z-arm forward, away from the system and then down.

   Select a location with convenient access to the black latch that attaches the LCMS tool to the Z-arm.

   **CAUTION:** Potential System Damage. Move the Z-arm in a controlled manner until it reaches the reference or teaching position. Do not hold the needle guide to move the Z-arm. This part is mechanically flexible and could lead to misalignment.

8. At the **Change Tool** step, accept the default parameters.

9. At the **Set Reference Point** step, open the top sample drawer, move the Z-arm to the reference position, and then click **Save**. Write down the coordinates of the reference position.

   The reference position is marked with a lunette, a disc with two concentric rings. The lower needle guide should touch the drawer.
10. At the Calibrate PALtools step, move the Z-arm to the reference position and then click Save.

11. Fine tune the reference position by following these steps.
   a. Press Enter.
   b. Click X, press Enter and then edit the value to match the value recorded in step 9. Press Enter to save the value.
   c. Repeat step 11.b to edit the values for Y and Z so that they match the values recorded in step 9.
   d. Click Next.

12. At the Teach PAL Modules step, move the Z-arm to the teaching position for each module. As necessary, click Next or Save to go to the next step.

   There are three modules: Injector LC 1, Peltier Stack 1, and LCMS Wash 1.
   a. For Step 1, Injector LC 1, move the Z-arm to the injection port on the valve. The lower needle guide should touch the injection port.
   b. For Steps 2 and 3, Peltier Stack 1, the teaching position is the same as the reference position. Fine tune it by repeating step 11.
c. For **Step 4**, LCMS Wash 1, move the Z-arm to Wash2, the wash station port that is farthest from the system. The lower needle guide should touch the injection port.

**Note:** When teaching the LCMS Wash 1, do not confuse the tool identifier, as shown in the wizard, and the physical port number. In the following example, the tool is LCMS Wash 1, and the port is Wash2. Use Wash2 as the teaching point. If Wash1 is used, then the wash cycle will not execute correctly, and the wash will be bypassed.

**Figure 6-42 Teaching the LCMS Wash**

13. For the **Check Teaching PALmodules** step, visually inspect the location of each module to make sure that the lower needle guide is directly over the teaching position. As necessary, click **Next** or **Save** to go to the next step.

14. Back up the settings. Refer to **Back Up the Configuration**.

**Back Up the Configuration**

**CAUTION:** Potential System Damage. Do not turn off the power to the M5 MicroLC system. If the power is interrupted during this process, the boot commands might become corrupted. If this happens, the system can no longer be started. The autosampler control board will have to be returned to the factory, so that the boot loader can be reconfigured.

1. Select **Options > Service > Installation Wizard** or **Create Configuration Backup**.
Tip! Alternatively, a backup can be created with the Options > Maintenance > Create Diagnostic Backup or Create Configuration Backup option.

Figure 6-43 Create Backup

2. Press **Start** to start the process.

   The blue LED blinks to indicate that the backup is in process. The backup takes several minutes. When it is complete, a message is shown.

Figure 6-44 Backup Complete Message
Restore the CTC PAL 3 Autosampler Settings

1. Start the PAL Virtual Terminal software and make sure that Access level is set to Extended User. Refer to Change the Access Mode to Extended User Level.
2. Click Options > Maintenance > Restore Backup.
3. At the prompt to remove the USB flash drive, click Yes to restart. Wait until the system restarts. This can take several minutes.

**Figure 6-45 Prompt to Restart**

![Service Issues]

The software will shutdown and re-boot the system automatically. Please press 'Ok'.

OK

4. Start the PAL Virtual Terminal software and make sure that the status icon is green and the envelope icon is not shown.

If the envelope icon is present, click Options > Pending Messages or Options > Service Messages and follow the instructions to resolve the issue.

**Figure 6-46 Status Icon**

![PAL RSI 11:47]

Modify the Calibration Method for a SCIEX TripleTOF® System

For a TripleTOF® system with a calibrant delivery system (CDS), the calibration method template must be modified so that the pump will continue to flow during the calibration run on the mass spectrometer. Without this modification, the signal stability on the mass spectrometer will be poor. This modification is initially performed by the SCIEX FSE during the installation of the system.

The calibration method template might need to be modified if:
Routine Maintenance

- The Analyst® TF software has been reinstalled or a different computer is connected to the system.
- The column or other system plumbing does not support a 40 μL/min flow rate.
- The initial mobile phase composition for the run is very different from the example experiment.
- The flow rate of the CDS is greater than 500 μL/min.

Create the LC Method for the Calibration Method Template

This method will run during the calibration run.

**CAUTION: Potential System Damage:** For experimental conditions other than those used in the System Integration Test, set the flow rate and the mobile phase composition as appropriate in the LC method. If the flow rate is too high, then the column might be damaged.

1. Click **LC Methods**.
2. In the **Name** field, type a name for the method, and then click **Save**.
3. On the **Run Conditions** tab, set the parameters as shown in the following figure. Refer to Figure 6-47.
4. On the **Gradient Profile** tab, set the profile as shown in the following figure. Refer to **Figure 6-48**.
   a. In the % field, type the value for mobile phase B at the beginning of the run.
   b. Type the appropriate value for the current column and plumbing configuration in the **Total flowrate** field.
   c. If the flow rate for the CDS is > 500 µL/min, then calculate the duration for the LC method as follows:
      
      \[
      \text{Duration} = \frac{1000}{\text{CDS flow rate}}
      \]
   d. Type the calculated duration in the **t = min** field.
5. Click **Save**, and then click **OK**.

**Update the Calibration Method Template**

Add the LC device and the LC method to the calibration method template.

1. Back up the `AutoCalPos.dam` file in a safe location.
   
   By default, the file is found in `D:\Analyst Data\Projects\API Instrument\Instrument Optimization\methods`.

2. Add the LC device to the `AutoCalPos` method in the Analyst® TF software.
   
   a. Activate the hardware profile that includes the M5 MicroLC system.
   
   b. In Windows Explorer, navigate to the location of the `AutoCalPos.dam` file.
      
      By default, the file is found in `D:\Analyst Data\Projects\API Instrument\Instrument Optimization\methods`.
   
   c. Double-click the `AutoCalPos.dam` file to open it in the **Acquisition Method Browser Editor**.
   
   d. Right-click **Acquisition Method** and then select **Add/remove device**.
e. In the Add/remove device methods dialog, select **Gradient 1** and then click **OK**.

**Figure 6-49 Add/remove device methods Dialog—M5 MicroLC-TE System**

3. Select the LC method for the Gradient 1 pump.
   a. In the Acquisition Method Browser pane, click **Gradient 1**.
   b. Click **(Browse)** to view the available LC methods.
   c. Click the name of the method created previously and then click **Open**.

4. Save the calibration method with the same name (**AutoCalPos**) in the original location.
This chapter contains best practices for using the M5 MicroLC systems.

Guidelines for Sample Preparation

Sample preparation methods commonly used for conventional HPLC are suitable for micro LC, but the flow path can clog if samples contain too much particulate matter.

For best results, follow these guidelines:

- Use HPLC- or MS-grade solvents at all times.
- Avoid the use of non-volatile salts and buffers such as CHAPS, phosphate, TRIS, HEPES, and perchlorates. These additives will foul the ion source and mass spectrometer orifice.
- Avoid overloading the column, and the trap column, if present, with sample.
  - For 0.3 mm and 0.5 mm i.d. columns: Use <12 μg of material
  - For 1 mm i.d. columns: Use <50 μg of material
- If necessary, centrifuge all samples at 10 000 RPM for 5 min to remove dust and particulates from the sample solution. Use the supernatant as the sample.
- Add a guard column (before the analytical column) to help protect the analytical column from impurities in the sample. Guard columns can be purchased from SCIEX.

Working with PEEK-clad Fused Silica Tubing

- Never cut PEEK-clad fused silica tubing. Cutting PEEK-clad fused silica tubing results in small particles of cut glass entering the flow path, leading to plugged tubing, valves, and electrodes.
- For all connections, seat the tubing at the bottom of the fitting.
- When connecting PEEK-clad fused silica tubing:
  1. Connect the tubing on the end farther from the mass spectrometer first.
  2. Turn on the pump and allow liquid to flow through the tubing to flush out any particulate matter.
  3. Allow liquid to flow for approximately 30 seconds before making the next connection.
• Do not over-tighten connections to PEEK-clad fused silica tubing. Over-tightening can damage tubing and lead to plugged tubing. Instead, tighten fittings until they are finger-tight, turn on the pump, and then inspect the fitting for the presence of solvent. If there is a leak, tighten the fitting about 1/16 turn at a time until there are no more leaks.

Guidelines for Micro HPLC Methods

The smaller columns used in micro high performance liquid chromatography (HPLC) require lower flow rates, smaller injection volumes, and different electrodes and tubing than traditional HPLC.

Flow Rate

When converting a method from traditional HPLC to micro HPLC, keep the flow velocity the same so that retention times do not change.

Flow velocity, \( FV \), is given by

\[
FV = Q \times A
\]

where:

\( Q = \) flow rate

\( A = \) cross-sectional area of the column

The following table demonstrates how flow rate varies by column diameter for (approximately) the same flow velocity. Refer to Table 7-1.

For other column diameters or other flow rates, a general guideline is that flow rate scales with the square of the column diameter.

Table 7-1 Equivalent Flow Rates for Micro HPLC

<table>
<thead>
<tr>
<th>Column Diameter (mm)</th>
<th>Flow Rate (µL/min)</th>
<th>Cross-sectional Area (mm²)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Traditional HPLC</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4.6</td>
<td>2100</td>
<td>16.62</td>
</tr>
<tr>
<td>2.1</td>
<td>450</td>
<td>3.46</td>
</tr>
<tr>
<td>Micro HPLC</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1.0</td>
<td>100</td>
<td>0.785</td>
</tr>
<tr>
<td>0.5</td>
<td>25</td>
<td>0.196</td>
</tr>
<tr>
<td>0.3</td>
<td>10</td>
<td>0.071</td>
</tr>
<tr>
<td>0.2</td>
<td>5</td>
<td>0.031</td>
</tr>
</tbody>
</table>
Flush the Electrode at the End of the Batch

The smaller diameter electrodes used for micro HPLC can clog. To reduce the chances of this occurring, add a sample at the end of the acquisition batch to flush the electrode.

1. Create an LC method for flushing the electrode.
2. Create an acquisition method that includes the LC method to flush the electrode.
3. Load a vial containing a 50:50 mixture of Mobile Phase A and Mobile Phase B in the cooled sample drawer.
4. Add the sample to the batch, assigning the acquisition method.
Troubleshooting Steps

1. Step back and look at the overall system. Is something obvious causing the problem?
   
   For example, is the instrument unplugged or improperly connected?

2. Compare the current system operation with the way the system operated before the problem started. Identify conditions such as pressures, power settings, or flow rates that are different from when the system was operating normally.
   
   For example, if the output pressure is usually 2500 psi for a certain method, is the system pressure currently in the same range, or drastically higher or lower?

3. In the following order, identify any symptoms which vary from normal system operation:
   
   a. System power on and initialization (initialization fails)
   b. System diagnostics such as flow stability
   c. Flow rate in each channel (high, low, erratic)
   d. Output pressure (high, low, erratic)

4. For each symptom, refer to Troubleshooting Tables and then perform the appropriate corrective actions.
   
   If this process does not correct the problem, contact SCIEX Technical Support at sciex.com/request-support.
## Troubleshooting Tables

### System Initialization

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Corrective Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>The power button on front of system is not lit.</td>
<td>The mains supply cable is not connected.</td>
<td>Make sure that the cable is connected to the system and plugged into the electrical outlet.</td>
</tr>
<tr>
<td></td>
<td>The power button on the back of system is in the Off position.</td>
<td>Press the power button on the back of the system.</td>
</tr>
<tr>
<td></td>
<td>The power button on the front of system is in the Off position.</td>
<td>Press the power button on the front of the system.</td>
</tr>
<tr>
<td></td>
<td>There is no power at the outlet.</td>
<td>Repair the electrical outlet.</td>
</tr>
<tr>
<td></td>
<td>The light failed but the system response is OK.</td>
<td>Contact SCIEX Technical Support at sciex.com/request-support.</td>
</tr>
<tr>
<td>The No Instrument Detected dialog is shown or the &quot;Not connected&quot; message is shown in the Acquisition window.</td>
<td>There is a communication error between the computer and the LC system.</td>
<td>Make sure that the instrument USB cable is securely connected to the computer USB port. Reboot the computer and cycle the power on the instrument.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Make sure that the IP address of the autosampler is correct. Refer to Assign the IP Address to the Autosampler.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Contact SCIEX Technical Support at sciex.com/request-support.</td>
</tr>
<tr>
<td>A loud hissing sound is coming from the instrument.</td>
<td>Air leaking is from the air inlet fitting.</td>
<td>Make sure that the air tubing is properly connected to the gas fitting.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Tighten the air inlet gas fitting.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Contact SCIEX Technical Support at sciex.com/request-support.</td>
</tr>
</tbody>
</table>
### Corrective Action

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Corrective Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>The hardware profile in the Analyst® software is not activated.</td>
<td>The hardware profile and the system hardware do not match.</td>
<td>Retrieve the configuration from Analyst® Device Driver. If the configuration does not exist, delete the hardware profile and create a new one. Refer to <a href="#">Create a Hardware Profile</a>.</td>
</tr>
</tbody>
</table>
| The Analyst® Device Driver window does not close when a hardware profile is deactivated. | The Analyst® Device Driver service is still running. | 1. Close the Analyst® software.  
2. Click Control Panel > All Control Panel Items > Administrative Tools > Services.  
3. Click AnalystService and then click Stop the service.  
4. Click AnalystDeviceDriverService and then click Stop the service.  
5. Click AnalystDeviceDriverService and then click Restart the service.  
6. Open the Analyst® software.  
7. If the problem persists, cycle the power on the instrument. |

### Valves

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Corrective Action</th>
</tr>
</thead>
</table>
| The injection valve does not switch positions. | The valve is not configured in the Eksigent Control software. | In the Eksigent Control software, click System > Instrument Configuration to open the Instrument Configuration dialog. Click the System tab and then select Eksigent Internal in the Injection Valve list.  
The valve is not connected to the actuator. | Contact SCIEX Technical Support at sciex.com/request-support. |
| The LC Method is not correct | | Review the LC method. |
### Troubleshooting

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Corrective Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>The auxiliary valve does not switch positions.</td>
<td>The valve is not configured in the Eksigent Control software.</td>
<td>In the Eksigent Control software, click <strong>System &gt; Instrument Configuration</strong> to open the Instrument Configuration dialog. Click the <strong>System</strong> tab and then select <strong>Eksigent Internal</strong> in the <strong>Injection Valve</strong> list.</td>
</tr>
<tr>
<td>No flow comes out of the port.</td>
<td>The valve is not plumbed correctly.</td>
<td>Make sure that the plumbing configuration is correct and reconfigure if needed. Refer to <strong>Plumb the Injection Valve</strong>.</td>
</tr>
<tr>
<td>Fluid is leaking from the valve.</td>
<td>A ferrule not properly seated in the port.</td>
<td>Inspect the tubing connection and make sure that the ferrule is properly seated.</td>
</tr>
<tr>
<td>When no column is connected, the system pressure (Pc) is unusually high.</td>
<td>The ports are plugged.</td>
<td>Use a syringe to manually flush each port with cleaning solvent. If flushing does not clean the port, then contact SCIEX Technical Support at sciex.com/request-support.</td>
</tr>
<tr>
<td>The ends of tubing are crushed.</td>
<td></td>
<td>Replace the tubing and do not over-tighten fittings.</td>
</tr>
<tr>
<td></td>
<td>The electronics are faulty.</td>
<td>Contact SCIEX Technical Support at sciex.com/request-support.</td>
</tr>
<tr>
<td></td>
<td>The actuator is faulty.</td>
<td>Contact SCIEX Technical Support at sciex.com/request-support.</td>
</tr>
<tr>
<td></td>
<td>The LC Method is not correct.</td>
<td>Review the LC method.</td>
</tr>
<tr>
<td></td>
<td>The ports are plugged.</td>
<td>Use a syringe to manually flush each port with cleaning solvent. If flushing does not clean the port, then contact SCIEX Technical Support at sciex.com/request-support.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Replace the rotor seal. Refer to <strong>Replace the Valve Rotor Seal</strong>.</td>
</tr>
<tr>
<td>Symptom</td>
<td>Possible Cause</td>
<td>Corrective Action</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>----------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>The system does not initiate an injection.</td>
<td>The system flow is unstable.</td>
<td>Purge and flush the pump. Refer to Purge the Mobile Phases and Flush the System. After the pump is flushed, equilibrate the system.</td>
</tr>
<tr>
<td></td>
<td>The flow stabilization is set too low.</td>
<td>In the Eksigent Control software, click System &gt; Instrument Configuration to open the Instrument Configuration dialog. Click the Advanced tab and then set the flow stabilization limit to a value greater than 100 nL/min.</td>
</tr>
<tr>
<td></td>
<td>The autosampler is configured to wait for injection but the Sample Injection setting in the Eksigent Control software is None.</td>
<td>In the LC Method Settings dialog, change Sample Injection to a value other than None.</td>
</tr>
<tr>
<td></td>
<td>The column oven is not at the specified temperature.</td>
<td>In the Direct Control dialog, lower the required temperature for the column oven. Refer to Allow the Column Oven to Pre-Heat.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Monitor the column oven temperature in the upper right corner of the Acquisition window in the Eksigent Control software and wait until the oven reaches the specified temperature. If the temperature is not reached within 15 minutes, then the column oven might not be working. Contact SCIEX Technical Support at sciex.com/request-support.</td>
</tr>
<tr>
<td></td>
<td>After replacing a module on the autosampler, the acquisition methods were not opened and saved.</td>
<td>If a module is replaced on the autosampler, each acquisition method must be saved again in the Analyst Device Driver. Refer to Configure the LCMS Tool Pumps.</td>
</tr>
</tbody>
</table>
### Troubleshooting

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Corrective Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>The flow rate is inconsistent.</td>
<td>The valve is leaking internally.</td>
<td>Replace the rotor seal. Refer to <a href="https://sciex.com/request-support">Replace the Valve Rotor Seal</a>. If the issue persists, then contact SCIEX Technical Support at <a href="https://sciex.com/request-support">sciex.com/request-support</a>.</td>
</tr>
<tr>
<td></td>
<td>The ports are plugged.</td>
<td>Use a syringe to manually flush each port with cleaning solvent. If flushing does not clean the port, then contact SCIEX Technical Support at <a href="https://sciex.com/request-support">sciex.com/request-support</a>.</td>
</tr>
<tr>
<td>The pressure drops at the beginning of each run.</td>
<td>The sample loop contains air bubbles.</td>
<td>In the Sample Table in the Batch Editor window, specify an <strong>Inj. Volume (µL)</strong> greater than the volume of the sample loop to make sure that the sample loop is completely filled with sample.</td>
</tr>
<tr>
<td>The relative standard deviation (RSD) between peak areas for successive runs is high.</td>
<td>The sample loop retains a small amount of the sample.</td>
<td>In the LC Method Settings dialog, edit the Trap Loading Method to add a step which washes the sample loop with the organic mobile phase between injections.</td>
</tr>
<tr>
<td>For a trap-and-elute experiment, there is carryover from one run to the next.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Column Oven

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Corrective Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>The column responds very slowly when changing temperature.</td>
<td>The oven is malfunctioning.</td>
<td>Contact SCIEX Technical Support at <a href="https://sciex.com/request-support">sciex.com/request-support</a>.</td>
</tr>
<tr>
<td>The temperature reads 47.</td>
<td>The oven is unplugged.</td>
<td>Make sure that the column oven is plugged in.</td>
</tr>
</tbody>
</table>
# Troubleshooting

## Autosampler

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Corrective Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>The sample drawers are damp.</td>
<td>The sample drawers contain condensation.</td>
<td>If the dampness is intermittent, then open the drawers 1 cm to 5 cm to allow air circulation when they system is not in use.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If the dampness is persistent, then pass clean, dry air or nitrogen through the sample drawers. Connect the gas line to the 1/8 inch fitting labeled <strong>Flush Gas</strong>, located at the lower right on the back of the system. Allow the gas to flow at 300 mL/min to 400 mL/min.</td>
</tr>
<tr>
<td>Peak areas are not reproducible from run to run.</td>
<td>The incorrect sample volume is aspirated because the syringe needle is too close to the bottom of the vial.</td>
<td>1. Click <strong>Method</strong> in the Analyst® Device Driver window to open the Instrument Control Method Editor window.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2. Make sure that the value for <strong>Height from Bottom of Sample Vial</strong> is greater than or equal to 2 mm.</td>
</tr>
<tr>
<td>The CTC PAL 3 Remote Terminal window is unresponsive.</td>
<td>The IP address for the Remote Terminal window is not correct.</td>
<td>1. Close the Remote Terminal window and then double-click the <strong>PAL VT</strong> icon to start the software.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2. In the Connecting Remote Terminal dialog, type <strong>192.168.99.230</strong>.</td>
</tr>
<tr>
<td></td>
<td>The IP address for the LAN connection to the autosampler is not correct.</td>
<td>Open the PAL 3 Properties dialog and make sure that the IP address is 192.168.99.231. Refer to <strong>Assign the IP Address to the Autosampler</strong>.</td>
</tr>
<tr>
<td></td>
<td>The Ethernet cable between the M5 MicroLC and the acquisition computer is not connected.</td>
<td>Connect the cable.</td>
</tr>
</tbody>
</table>
## Troubleshooting

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Corrective Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>The CTC PAL 3 Remote Terminal window is unresponsive.</td>
<td>The autosampler initialization did not complete.</td>
<td>1. Close the Remote Terminal window.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2. Turn the M5 MicroLC power off and then on. Wait for the Z-arm to stop moving.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3. Double-click the PAL VT icon to start the software.</td>
</tr>
<tr>
<td>The autosampler script is missing from the Script list in the Instrument Control Method Editor window.</td>
<td>The autosampler script is missing from Analyst® Device Driver.</td>
<td>Import the script again using the Script Manager in Analyst® Device Driver. Refer to Import the Autosampler Scripts.</td>
</tr>
<tr>
<td>Parameters for the autosampler cannot be edited in the Remote Terminal window.</td>
<td>The access mode is set to User Level.</td>
<td>Change the access mode to Extended User Level. Refer to Change the Access Mode to Extended User Level.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note:</strong> If the Remote Terminal window is inactive for 60 minutes, the software automatically reverts to User Level access mode.</td>
</tr>
<tr>
<td>When the Z-arm stops moving at start up, it is located at the left side of the sample drawers instead of the home position above the wash station.</td>
<td>The autosampler initialization did not complete.</td>
<td>1. Close the Remote Terminal window.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2. Turn the M5 MicroLC power off and then on. Wait for the Z-arm to stop moving.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3. Double-click the PAL VT icon to start the software.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>4. If the problem continues, then complete the PAL 3 installation wizard. Refer to Complete the CTC PAL 3 Installation Wizard.</td>
</tr>
</tbody>
</table>
## Pumps

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Corrective Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>The system pressure (Pc) or pump pressures (Pa &amp; Pb) show pressure but flow is off.</td>
<td>The zero setting for the pressure sensors is incorrect.</td>
<td>Re-initialize the pressure transducers. Refer to Re-initialize the Pressure Transducers.</td>
</tr>
<tr>
<td>No liquid comes out of the waste tubing when purging.</td>
<td>The pump contains trapped air.</td>
<td>Purge and flush the pump. Refer to Purge the Mobile Phases and Flush the System.</td>
</tr>
<tr>
<td></td>
<td>The internal filters are plugged.</td>
<td>Purge the pumps and inspect the flow through the waste tubing after approximately 8 purges. Refer to Purge the Mobile Phases and Flush the System. If the flow is very low or intermittent, then the filter should be changed. Contact SCIEX Technical Support at sciex.com/request-support.</td>
</tr>
<tr>
<td>There is a leak in the system before the purge valve.</td>
<td></td>
<td>Contact SCIEX Technical Support at sciex.com/request-support.</td>
</tr>
<tr>
<td>The pump re-strokes frequently (&quot;Pump has reached end of stroke&quot; error message appears).</td>
<td>The pump remains on long enough to prompt a re-stroke.</td>
<td>For the current flow rate, calculate the time to pump approximately 600 µL. Verify that the pump re-strokes at approximately that time interval.</td>
</tr>
<tr>
<td></td>
<td>The check valve leaks.</td>
<td>Contact SCIEX Technical Support at sciex.com/request-support.</td>
</tr>
<tr>
<td>The pump does not re-stroke at the end of a run.</td>
<td>The optical sensor is not working correctly.</td>
<td>Contact SCIEX Technical Support at sciex.com/request-support.</td>
</tr>
<tr>
<td>The pump flushes quickly but does not deliver approximately 600 µL per stroke.</td>
<td>The system has a leak.</td>
<td>Contact SCIEX Technical Support at sciex.com/request-support.</td>
</tr>
</tbody>
</table>
### Troubleshooting Table

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Corrective Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>The purge output drips slowly.</td>
<td>The internal filters are plugged.</td>
<td>Purge the pumps and inspect the flow through the waste tubing after approximately 8 purges. Refer to <a href="https://sciex.com/request-support">Purge the Mobile Phases and Flush the System</a>. If the flow is very low or intermittent, then the filter should be changed. Contact SCIEX Technical Support at sciex.com/request-support.</td>
</tr>
<tr>
<td>The flow rate is 0 when with 100% power indicated. The system pressure (Pc) and pump pressures (Pa and Pb) are all low.</td>
<td>There is no gas to the system.</td>
<td>Connect 100 psi clean, dry air or nitrogen to the instrument gas inlet.</td>
</tr>
<tr>
<td>The system was not properly purged and flushed.</td>
<td></td>
<td>Purge and flush the pump. Refer to <a href="https://sciex.com/request-support">Purge the Mobile Phases and Flush the System</a>.</td>
</tr>
<tr>
<td>The system responds sluggishly when changing flow rates.</td>
<td>The mobile phases are incorrect.</td>
<td>Verify the settings in the Mobile Phases dialog.</td>
</tr>
<tr>
<td>The system was not properly purged and flushed.</td>
<td>The pump controller is out of tune.</td>
<td>Contact SCIEX Technical Support at sciex.com/request-support.</td>
</tr>
<tr>
<td>The system does not reach desired flow rate.</td>
<td>The internal filters are plugged.</td>
<td>Purge the pumps and inspect the flow through the waste tubing after approximately 8 purges. Refer to <a href="https://sciex.com/request-support">Purge the Mobile Phases and Flush the System</a>. If the flow is very low or intermittent, then the filter should be changed. Contact SCIEX Technical Support at sciex.com/request-support.</td>
</tr>
<tr>
<td>The flow rate is too high for the system back pressure.</td>
<td></td>
<td>In the Direct Control dialog, decrease the flow rate.</td>
</tr>
<tr>
<td>The gas pressure is too low.</td>
<td></td>
<td>Verify that the gas supply has a pressure of 100 psi.</td>
</tr>
<tr>
<td>The system cannot meet the required flow rate within the specified tolerance.</td>
<td></td>
<td>Increase the flow stabilization limit in the <strong>Advanced</strong> tab of the Instrument Configuration dialog of the Eksigent Control software.</td>
</tr>
<tr>
<td>The system has a leak.</td>
<td></td>
<td>Contact SCIEX Technical Support at sciex.com/request-support.</td>
</tr>
<tr>
<td>Symptom</td>
<td>Possible Cause</td>
<td>Corrective Action</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>---------------------------------------------------</td>
<td>-----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>The flow rate does not initialize at the start of the run.</td>
<td>The system has a leak.</td>
<td>Contact SCIEX Technical Support at sciex.com/request-support.</td>
</tr>
<tr>
<td></td>
<td>The internal filters are plugged.</td>
<td>Purge the pumps and inspect the flow through the waste tubing after approximately 8 purges. Refer to Purge the Mobile Phases and Flush the System. If the flow is very low or intermittent, then the filter should be changed. Contact SCIEX Technical Support at sciex.com/request-support.</td>
</tr>
<tr>
<td>The flow rate is inaccurate but there are no signs of leakage.</td>
<td>The mobile phases are incorrect.</td>
<td>Verify the settings in the Mobile Phases dialog.</td>
</tr>
<tr>
<td></td>
<td>The k-values are incorrect.</td>
<td>Calibrate the flowmeters. Refer to Calibrate the Flowmeters.</td>
</tr>
<tr>
<td>The flow rate does not stabilize during a run.</td>
<td>Tubing or a fitting is partially plugged.</td>
<td>Starting as far downstream as possible from the pump outlet, remove each tube or fitting, one at a time, until the pressure drops dramatically. Replace the plugged item. Refer to Test the Fluid Connections.</td>
</tr>
<tr>
<td></td>
<td>The pump contains trapped air.</td>
<td>Purge and flush the pump. Refer to Purge the Mobile Phases and Flush the System.</td>
</tr>
<tr>
<td></td>
<td>The mobile phases are incorrect.</td>
<td>Verify the settings in the Mobile Phases dialog.</td>
</tr>
<tr>
<td></td>
<td>The pump controller is out of tune.</td>
<td>Contact SCIEX Technical Support at sciex.com/request-support.</td>
</tr>
<tr>
<td></td>
<td>The column temperature is not stable.</td>
<td>Monitor the column oven temperature in the upper right corner of the Acquisition window in the Eksigent Control software. If the temperature fluctuates more than about 2 °C, then contact SCIEX Technical Support at sciex.com/request-support.</td>
</tr>
<tr>
<td>The system pressure (Pc) is unusually low but the flow rate is OK.</td>
<td>There is a loose connection after the mixing Tee.</td>
<td>Inspect all connections for leaks.</td>
</tr>
</tbody>
</table>
## Troubleshooting

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Corrective Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>The system pressure (Pc) is low and flow rate is OK but the pump pressures (Pa and Pb) are high.</td>
<td>The k-values are incorrect.</td>
<td>Calibrate the flowmeters. Refer to <a href="#">Calibrate the Flowmeters</a>.</td>
</tr>
<tr>
<td></td>
<td>A flow module is plugged.</td>
<td>Contact SCIEX Technical Support at <a href="#">sciex.com/request-support</a>.</td>
</tr>
<tr>
<td>The system pressure (Pc) is very high.</td>
<td>Tubing or a fitting is plugged.</td>
<td>Starting as far downstream as possible from the pump outlet, remove each tube or fitting, one at a time, until the pressure drops dramatically. Replace the plugged item. Refer to <a href="#">Test the Fluid Connections</a>.</td>
</tr>
<tr>
<td></td>
<td>The trap column is plugged.</td>
<td>Replace the trap column.</td>
</tr>
<tr>
<td>The flow noise is excessive.</td>
<td>The pump contains trapped air.</td>
<td>Purge and flush the pump. Refer to <a href="#">Purge the Mobile Phases and Flush the System</a>.</td>
</tr>
<tr>
<td></td>
<td>The pump controller is out of tune.</td>
<td>Contact SCIEX Technical Support at <a href="#">sciex.com/request-support</a>.</td>
</tr>
<tr>
<td>The measured flow does not follow the flow profile.</td>
<td>The pump controller is out of tune.</td>
<td>Contact SCIEX Technical Support at <a href="#">sciex.com/request-support</a>.</td>
</tr>
<tr>
<td>The pump pressures (Pa and Pb) are maximized to &lt;12 000 psi at 100% pump power.</td>
<td>The gas pressure is too low.</td>
<td>Verify that the gas supply has a pressure of 100 psi.</td>
</tr>
<tr>
<td></td>
<td>The zero setting for the pressure sensors is incorrect.</td>
<td>Re-initialize the pressure transducers. Refer to <a href="#">Re-initialize the Pressure Transducers</a>.</td>
</tr>
<tr>
<td></td>
<td>The gain setting for pressure is incorrect.</td>
<td>In the <strong>Calibration Values</strong> tab of the Hardware Diagnostics dialog, make sure that the pump pressures (in the <strong>Scale Parameter</strong> field) are approximately 2800 psi/V. If the value is not 2800, then contact SCIEX Technical Support at <a href="#">sciex.com/request-support</a>.</td>
</tr>
</tbody>
</table>

### Test the Fluid Connections

**CAUTION: Potential Operator Injury.** To avoid the possibility of solvent exposure, be sure to have a vial or other container available to collect the solvent leaving the system.
1. Disconnect all the exits in the flow path except for the tubing coming from the G1 pump.

2. In the Direct Control dialog, set the flow conditions to 80% A (water):20% B (acetonitrile) and set the Total flowrate based on the system configuration.
   - For a low-flow system, type 5 µL/min.
   - For a micro-flow or high-flow system, type 40 µL/min.

3. Click Start.

4. Calculate the approximate pressure for the items in the flow path using Table 8-1. (Initially, the only component is the 10 cm of 50 µm i.d., 1/32 inch o.d. tubing coming from the pump.)

Table 8-1 Approximate Pressure Changes for Tubing and Other Components

<table>
<thead>
<tr>
<th>Item</th>
<th>Pressure (psi)</th>
</tr>
</thead>
<tbody>
<tr>
<td>5 µL sample loop</td>
<td>0</td>
</tr>
<tr>
<td>50 µL sample loop</td>
<td>0</td>
</tr>
<tr>
<td>Gray PEEKsil tubing, 50 µm i.d., 1/32 inch o.d., 10 cm</td>
<td>63</td>
</tr>
<tr>
<td>Gray PEEKsil tubing, 50 µm i.d., 1/32 inch o.d., 20 cm</td>
<td>126</td>
</tr>
<tr>
<td>Orange PEEKsil tubing, 25 µm i.d., 1/32 inch o.d., 10 cm</td>
<td>1009</td>
</tr>
</tbody>
</table>

Note: The calculated pressures in Table 8-1 depend on the mobile phase composition. For mobile phases other than 80% A (water):20% B (acetonitrile), the values in Table 8-1 are not correct.

5. Compare the calculated pressure to the actual pressure (Pc) in the Acquisition window of the Eksigent Control software.
   - If the pressure is close to the value, then the system is working as expected.
   - If the pressure is higher, then there might be a clog. Replace the part.
   - If the pressure is low, then there might be a leak. Tighten the connection or replace the part.

6. Stop the flow and then connect the next item in the flow path.

7. Start the flow again and then observe the pressure and compare it to the calculated value.

8. Repeat for the remaining components in the flow path, including the column and the ion source.

9. Stop the flow.
Move the System

This section describes how to move the SCIEX M5 MicroLC system from one location to another. It assumes that the new location includes a mass spectrometer and that the system is on a wheeled cart. Complete disassembly of the system is not required.

Instructions for setting up the system to use a different acquisition computer are also given, as well as instructions for storing the system.

Disconnect the System at the Original Location

1. Close the Eksigent Control software and mass spectrometer software, if it is open.
2. Using the switch on the back of the system, turn off the power to the system and then disconnect the mains supply cable.
3. Turn off the gas supply.
4. Disconnect the system from the gas.
   - For the M5 MicroLC system: Push in the red plastic ring while pulling out the tubing to remove the gas tubing from the back of the pump.
   - For the M5 MicroLC-TE system: Disconnect the gas supply at the Tee. The system is still pressurized, so it may be difficult to remove the tubing.
5. Disconnect the USB cable between the LC system and the acquisition computer.
6. Disconnect the MS interface cable between the LC system and the mass spectrometer.
7. Disconnect the Ethernet cable between the LC system and the acquisition computer.
8. Disconnect the tubing from the column at the ion source.

Install the System at the New Location

WARNING! Lifting Hazard. Make sure that at least four people or a lifting device are available to lift the LC system. Follow established safe lifting procedures. Refer to the Site Planning Guide for the weights of system components.
WARNING! Crushing Hazard. Wear protective footwear when moving heavy objects.

1. Carefully move the system to the new location.
2. Connect the USB cable to the port labeled USB on the back of the LC system and to the acquisition computer.
3. Connect the MS interface cable to the port labeled I/O G1 on the back of the LC system and to the mass spectrometer.
4. Connect the LAN cable to the port labeled LAN on the back of the LC system and to an Ethernet port on the acquisition computer.
5. Connect the gas tubing to the pump.
   - For the M5 MicroLC system: Push the tubing straight in the fitting on the back of the pump.
   - For the M5 MicroLC-TE system: Connect the gas supply to the Tee.
6. Connect the gas tubing to a source of gas (clean, dry, compressed air or nitrogen, regulated to 100 psi).
7. Connect the column outlet tubing to the ion source.
8. Connect the system to the mains supply.
9. Connect the mains supply cable and, using the switch on the back of the system, turn on the power.
10. If the acquisition computer was not moved, then set up the new acquisition computer. Refer to Set Up a New Computer for Use with the System.

Set Up a New Computer for Use with the System

The following procedures describe how to set up a new acquisition computer for use with the M5 MicroLC system.

*Note:* The Analyst® software must be installed on the acquisition computer first. Refer to the Analyst® Software Installation Guide.

**Install the Analyst® Device Driver**

Install the latest available version of the Analyst® Device Driver (ADD) software. The software can be downloaded from sciex.com/software-support/software-downloads.

*Note:* Make sure to use the PAL 3 RC.NET driver recommended for the ADD software version.

- Install the Analyst® Device Driver (ADD) software by following the instructions in the Release Notes.
Move the System

**Note:** Admin privileges are required to install the ADD software, and the Analyst® software must be closed.

**Install the Eksigent Control Software and Transfer the Settings**

To use the M5 MicroLC system with a different acquisition computer, install the Eksigent Control software on the new computer, transfer important files from the existing computer, and then configure the software on the new computer.

**Required Materials**

- Eksigent Control software, downloaded from sciex.com/software-support/software-downloads. If the new computer does not have internet access, then save the installer to a USB flash drive.
- USB flash drive

**Note:** The following instructions assume that the Analyst® software is already installed on the new computer.

**Note:** Use the following procedure to use the same version of the Eksigent Control software on the new acquisition computer. To update the Eksigent Control software as part of the move to a new computer, follow the instructions provided with the software update.

1. Export the system settings .reg file from the current computer and copy them to the USB flash drive.
   a. Start the Eksigent Control software.
b. Click **System > Instrument Configuration**.

![Instrument Configuration Dialog—System Tab](image)

**Figure 9-1 Instrument Configuration Dialog—System Tab**

c. Click **Export Settings** in the lower left corner.

The instrument settings are exported and a dialog showing the location of the backup file opens.

d. Write down the location for use in the following step and then click **OK**.

e. In Windows Explorer, navigate to the location of the Eksettings.reg file and then copy it to the USB flash drive.

2. In Window Explorer, copy the settings folder from the current computer to the USB flash drive.

   a. Navigate to the installation directory.

      - For 32-bit operating systems—C:\Program Files\EksigentNanoLC
      - For 64-bit operating systems—C:\Program Files (x86)\EksigentNanoLC

   b. Copy the settings folder to the USB flash drive.

3. Install the Eksigent Control software on the new computer.

   a. Using the switch on the front of the system, turn off the M5 MicroLC system.
Move the System

b. Double-click the downloaded file for the Eksigent Control software and then follow the prompts to install the software.

4. Copy the settings folder to the new computer.
   a. Insert the USB flash drive into a USB port on the new computer.
   b. Copy the settings folder from the USB flash drive to the Eksigent NanoLC folder.
      • For 32-bit operating systems—C:\Program Files\EksigentNanoLC
      • For 64-bit operating systems—C:\Program Files (x86)\EksigentNanoLC

5. Install the driver for the Analyst® software and then load the settings from the EKSettings.reg file.
   a. From the Start menu, select Eksigent > Driver Configuration. If the User Account Control dialog appears, click Yes to continue.

   Figure 9-2 Eksigent Driver Configuration Utility

   b. In the Analyst section, select Eksigent System Driver and then click Yes.

   Note: If the Analyst section is unavailable, then the Analyst® software is not installed. Install it, and repeat this step.

   c. To load the settings, click Calibration Disk and navigate to the EKSettings.reg file on the USB flash drive.
   d. Click Apply and then Exit.
6. Before using the system, **Re-initialize the Pressure Transducers.**

**Assign the IP Address to the Autosampler**

1. Click **Start > Control Panel > Network and Sharing Center.**
2. Click **Change adapter settings.**

   The Network Connections window opens.
3. (Optional) Rename the connection for easier identification.
   a. Right-click **Local Area Connection X**, where X is a number, and then select **Rename**.

   **Tip!** To identify the correct Local Area Connection, disconnect the Ethernet cable coming from the autosampler and then wait a few seconds. The correction connection will show "Not connected". Make sure to connect the Ethernet cable.

   b. Type **PAL 3** and then press **Enter**.

**Figure 9-3 Local Area Connection after Renaming**

4. Right-click **PAL3** and then select **Local Area Connection > Properties** to open the Local Area Connection Properties dialog.
Move the System

5. On the **Networking** tab, click **Internet Protocol Version 4 (TCP/IPv4)** and then click **Properties**.
6. Select **Use the following IP address** and then type the following:

- For the **IP address**, type **192.168.99.231**.
- For the **Subnet mask**, type **255.255.255.0**.
For the **Default gateway**, type `1.1.1.1`.

7. Click **OK** and then click **Close**.

### Install the CTC PAL 3 Driver and Configure the Device

**Note:** The CTC PAL 3 driver is included with the Analyst® Device Driver installer.

The following procedure includes configuring the cooled sample drawers with V54 trays. The drawers can also be configured with microtiter plates. Refer to [Optional] Set Up the Autosampler to Use Microtiter Plates.

1. Open the Analyst® software.
2. Make sure that the hardware profile is deactivated.
3. On the Navigation bar, under **Companion Software**, double-click **Analyst Device Driver**.
Figure 9-4 Analyst Device Driver

4. In the Analyst Device Driver window, click Configure.

Figure 9-5 LC Device Configuration Dialog

5. If necessary, click **CTC Analytics LC** system in the left panel and then expand the CTC Analytics LC group to view the peripheral devices for that group.
6. Click **CTC PAL3 LC Sampler** and then click >.

7. Click **Configure**.
8. Type **192.168.99.230** in the **IP Address or Hostname** field and then click **Retrieve Configuration**.

**Figure 9-8 Configure CTC PAL3 LC Sampler Dialog with Configuration Retrieved**

9. Configure the trays in the cooled sample drawers.
a. Click **Tray Configuration** to open the Tray Configuration dialog.

**Figure 9-9 Tray Configuration Dialog**

b. Click the list in 1 and select **VT54**.
c. Click the lower list and select Vial 2mlc.

**Figure 9-10 Selecting Vial for Slot 1 in Drawer 1**

![Image of tray configuration dialog]

d. Repeat step 9.b and 9.c to configure the other slot for Drawer 1.

e. Configure the other slot and then configure the other drawers.

f. Click **OK** to close the Tray Configuration dialog.

The Analyst Device Driver retrieves the configuration from the autosampler.

10. Click **OK** to close the Configure CTC PAL3 LC Sampler dialog and then click **OK** to close the LC Device Configuration dialog.

**Import the Autosampler Scripts**

1. Click **Status** in the Analyst Device Driver window.
Move the System

Figure 9-11 Analyst Device Driver

The Status window to configure the PAL3 autosampler opens.

Figure 9-12 Status Window for PAL3 Autosampler

2. Right-click in the PAL3 box in the Status window and then click **Show Script Manager**.
3. Click **Import Scripts**.

4. Navigate to the folder where PAL3 scripts are stored.
   - On the Windows 7, 32 bit operating system, navigate to the C:\Program Files\Eksigent NanoLC\settings\EKPAL3 folder.
   - On the Windows 7, 64-bit operating system, navigate to the C:\Program Files (x86)\Eksigent NanoLC\settings\EKPAL3 folder.

   The folder contains the scripts M5_Direct Inject, M5_TrapElute, and M5_Advanced.

5. **Ctrl-click** each M5 script and then click **Open**.

   The imported scripts are shown in the PAL3 Scripts dialog.
6. Click **OK** in the PAL3 Scripts dialog.

**Install and Configure the PAL Virtual Terminal Software**

1. Install the PAL Virtual Terminal software.
a. Open a web browser window and type **http://192.168.99.230** and then press **Enter**.

The web browser page updates with information about the autosampler.

**Figure 9-15 Autosampler Connection in Web Browser**

b. Click **Desktop setup** at the bottom of the window to download the installer.

c. Click **Pal3DesktopSetup.exe** and then click **Run** to install the Remote Terminal software.
d. Navigate to C:\Program Files\PAL3 System\Integration\Applications\2.4.51, right-click TerminalDesktop.exe and then create a shortcut on the Windows desktop.

The PAL VT icon appears on the desktop.

Figure 9-16 PAL VT Icon

2. Double-click the PAL VT icon.

3. In the Connecting Remote Terminal dialog, set the parameters for the remote terminal.

Figure 9-17 Connecting Remote Terminal Dialog

a. In the Port list, click Auto.

b. In the Transport list, click Http.

c. Click Connect.

The Remote Terminal window opens.
Troubleshoot the Move to a New Computer

When using a different computer than the one on which the M5 MicroLC system was originally installed, the following procedure might be helpful in resolving any issues.

Issues with Gain and Integral Settings for the Pump

Incorrect integral or gain settings might cause flow instability or gas venting when the pumps are on. Use the following instructions to troubleshoot this issue.

1. On the new computer, in the Eksigent Control software, select System > Hardware Diagnostics and then click the Calibration Values tab.

2. Write down the gain and int values found in the Control Parameters (Field Service) section near the bottom of the tab.
3. Repeat the preceding steps on the old computer and then compare the values for the two computers.
   The first two digits in each value should be the same. If they are not, then contact SCIEX Technical Support.

Prepare the System for Storage

1. Change the mobile phases in the solvent bottles to isopropanol (IPA).

   **Note:** Removing the aqueous mobile phases is required to reduce the possibility of bacterial growth.

2. Purge and flush the system. Refer to Purge the Mobile Phases and Flush the System.
3. Plug all pump inlets and outlets.
4. Label the system for storage to make sure that the next user is aware that the system contains IPA.
## System Specifications

### System

| Dimension (L × W × D) | 98 cm × 58 cm × 70 cm (38.6 inches × 22.8 inches × 27.6 inches)  
For a side-mounted solvent tray, add 14 cm (5.6 inches) to width. |

| Weight | • M5 MicroLC system: 54 kg (119 pounds)  
• M5 MicroLC-TE system: 68 kg (150 pounds) |

| Electrical | • Input line voltage: 100 V to 240 V AC  
• Input line frequency: 50Hz or 60 Hz  
• Input current: 2.5 A |

| Instrument control | Eksigent Control software with driver for the Analyst® software |

| I/O | • Communication: USB 2.0  
• TTL: Run in  
• Contact closure: Ready out/run out/Valve out/2 programmable auxiliary  
• LAN |

| Working environment | • Altitude: ≤2000 m (6562 feet) above sea level  
• Humidity: 20% to 80%, non-condensing  
• Temperature: 15 °C to 30 °C (59 °F to 86 °F) |

### Pump

| Flow rate range | Analytical gradient: 1 µL/min to 10 µL/min, 5 µL/min to 50 µL/min, or 20 µL/min to 200 µL/min  
(M5 MicroLC-TE only) Loading gradient: 20 µL/min to 200 µL/min |

| Gradient delay volume | <3 µL |

| Maximum pressure | 10 000 psi |

| Retention time reproducibility | <0.5% RSD at 20 µL/min for the 5 µL/min to 50 µL/min configuration |
## System Specifications

<table>
<thead>
<tr>
<th>Wetted parts</th>
<th>Stainless steel, PEEK, fused silica, titanium, FEP, PTFE, and ceramic</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Autosampler</strong></td>
<td></td>
</tr>
<tr>
<td>Injection reproducibility</td>
<td>• Full loop: &lt;1% RSD</td>
</tr>
<tr>
<td></td>
<td>• Partial loop: &lt;2% RSD</td>
</tr>
<tr>
<td>Injection valves</td>
<td>• 6 ports</td>
</tr>
<tr>
<td></td>
<td>• 1/32 inch connections</td>
</tr>
<tr>
<td></td>
<td>• Port-to-port volume &lt;60 nL</td>
</tr>
<tr>
<td></td>
<td>• Maximum pressure: 10 000 psi</td>
</tr>
<tr>
<td></td>
<td>• 316 stainless steel with proprietary coating</td>
</tr>
<tr>
<td>Injection volume</td>
<td>2 µL to 50 µL</td>
</tr>
<tr>
<td>Sample carryover</td>
<td>&lt;0.005% (benzophenone)</td>
</tr>
<tr>
<td>Sample capacity</td>
<td>• 6 positions for trays or microtiter plates</td>
</tr>
<tr>
<td></td>
<td>• 54 2 mL vials per tray</td>
</tr>
<tr>
<td></td>
<td>• Microtiter plates:</td>
</tr>
<tr>
<td></td>
<td>• Standard depth 96-well</td>
</tr>
<tr>
<td></td>
<td>• Deep 96-well</td>
</tr>
<tr>
<td></td>
<td>• 384-well</td>
</tr>
<tr>
<td>Sample cooling temperature</td>
<td>Minimum 4 °C (room temperature –20 °C)</td>
</tr>
<tr>
<td>Syringe volume</td>
<td>100 µL</td>
</tr>
<tr>
<td>Wetted parts</td>
<td>Stainless steel, PEEK, FEP, glass</td>
</tr>
</tbody>
</table>
Order Parts

1. Order parts from SCIEX in any of the following ways:

   - **Telephone:** (877) 740-2129, Option 1 (toll-free, United States only), or go to sciex.com/contact-us to find a local office.
   - **E-mail:** Sales.Americas@sciex.com
   - **Fax:** (800) 343-1346

2. Order columns from Phenomenex in any of the following ways:

   - **Telephone:** (310) 212-0555, or visit phenomenex.com
   - **E-mail:** info@phenomenex.com
   - **Fax:** (310) 328-7768

Consumables and Accessories

Table B-1 Consumables and Accessories—Ordered by Description

<table>
<thead>
<tr>
<th>Part Number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>5052374</td>
<td>Injection port</td>
</tr>
<tr>
<td>5043351</td>
<td>LCMS tool pump module</td>
</tr>
<tr>
<td>5043354</td>
<td>LCMS tool, tubing kit</td>
</tr>
<tr>
<td>620-00071</td>
<td>Plate, 54-vial, blue for autosampler</td>
</tr>
<tr>
<td>5023797</td>
<td>Syringe needle guide</td>
</tr>
<tr>
<td>5031383</td>
<td>Syringe needle kit, with hubs and nuts for autosampler LCMS tool (3-pack)</td>
</tr>
<tr>
<td>4460861</td>
<td>Syringe, 100 µL</td>
</tr>
</tbody>
</table>
# Consumables and Accessories

**Table B-1 Consumables and Accessories—Ordered by Description (continued)**

<table>
<thead>
<tr>
<th>Part Number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>4460827</td>
<td>Syringe, replacement plungers (10-pack)</td>
</tr>
<tr>
<td>620-00162</td>
<td>Tubing, waste for active wash</td>
</tr>
</tbody>
</table>

## Consumables

<table>
<thead>
<tr>
<th>Part Number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>200-00388</td>
<td>In-line filter assembly (includes 5 filter capsules)</td>
</tr>
<tr>
<td>5027467</td>
<td>Trap column cartridge holder, required for ChromXP cartridges</td>
</tr>
<tr>
<td>5028897</td>
<td>Trap column cartridge, ChromXP C18 3 µm, 120 Å, 0.3 mm i.d. × 1 cm (5-pack)</td>
</tr>
<tr>
<td>5028898</td>
<td>Trap column cartridge, ChromXP C18 3 µm, 120 Å, 0.5 mm i.d. × 1 cm (5-pack)</td>
</tr>
<tr>
<td>910-00103</td>
<td>Vial caps, snap caps with split septa (100-pack)</td>
</tr>
<tr>
<td>800-00209</td>
<td>Vials, 2 mL (100-pack)</td>
</tr>
</tbody>
</table>

## Fittings and Ferrules

<table>
<thead>
<tr>
<th>Part Number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>5019820</td>
<td>Ferrule, 1/32 inch to 1/16 inch 10-32 port (5-pack)</td>
</tr>
<tr>
<td>910-00091</td>
<td>Ferrule, 1/8 inch, super flangeless (10-pack)</td>
</tr>
<tr>
<td>910-00087</td>
<td>Ferrule, stainless steel 1/32 inch (10-pack)</td>
</tr>
<tr>
<td>5019821</td>
<td>Fitting, 1/32 inch to 1/16 inch 10-32 port (5-pack)</td>
</tr>
<tr>
<td>200-00342</td>
<td>Fitting, column 6-32 threading</td>
</tr>
<tr>
<td>5019301</td>
<td>Fitting, drain collar</td>
</tr>
<tr>
<td>200-00252</td>
<td>Fitting, flangeless tube end 1/16 inch ferrule</td>
</tr>
<tr>
<td>200-00418</td>
<td>Fitting, headless PEEK, 1/32 inch o.d.</td>
</tr>
<tr>
<td>5016413</td>
<td>Fitting, union straight hex 6-32 F × 6-32 F</td>
</tr>
<tr>
<td>910-00085</td>
<td>Nut, 1/32 inch o.d., 0.45 inches long (10-pack)</td>
</tr>
<tr>
<td>910-00090</td>
<td>Nut, 1/8 inch super-flangeless (10-pack)</td>
</tr>
<tr>
<td>200-00446</td>
<td>Nut, PEEK, 1/8 Inch</td>
</tr>
<tr>
<td>5024174</td>
<td>Nut, gold-colored, 6-32 thread 3/16 (1 nut)</td>
</tr>
<tr>
<td>200-00413</td>
<td>Union, stainless steel, 1/32 inch o.d. ports, 0.50 mm</td>
</tr>
</tbody>
</table>

## Miscellaneous

<table>
<thead>
<tr>
<th>Part Number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>801-00075</td>
<td>Bottle, 1 L with drilled cap</td>
</tr>
<tr>
<td>801-00067</td>
<td>Bottle, 250 mL with drilled cap</td>
</tr>
</tbody>
</table>
Table B-1 Consumables and Accessories—Ordered by Description (continued)

<table>
<thead>
<tr>
<th>Part Number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>5017797</td>
<td>Bottle, seal rinse</td>
</tr>
<tr>
<td>400-00465</td>
<td>Cable, USB, 3 m</td>
</tr>
<tr>
<td>700-00020</td>
<td>Cable, power supply to instrument</td>
</tr>
<tr>
<td>801-00063</td>
<td>Calibration kit for low-flow (1 µL/min to 10 µL/min) configuration</td>
</tr>
<tr>
<td>5018262</td>
<td>Calibration kit for micro-flow (5 µL/min to 50 µL/min) and high-flow (20 µL/min to 200 µL/min) configurations</td>
</tr>
<tr>
<td>801-00020</td>
<td>Calibration pipette, 20 µL</td>
</tr>
<tr>
<td>200-00396</td>
<td>Calibration pipette, 100 µL</td>
</tr>
<tr>
<td>200-00383</td>
<td>Calibration pipette, 200 µL</td>
</tr>
<tr>
<td>200-00329</td>
<td>Mobile phase filter with 10 µm frit</td>
</tr>
<tr>
<td>5042103</td>
<td>Trap column holder arm</td>
</tr>
<tr>
<td>5042106</td>
<td>Tray, for solvent bottles on instrument</td>
</tr>
<tr>
<td>100-00567</td>
<td>Wrench, for 1/32 inch and 1/16 inch nuts</td>
</tr>
</tbody>
</table>

**Tubing**

<table>
<thead>
<tr>
<th>Part Number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>205-00089</td>
<td>Tubing, PEEK-clad fused silica, 25 µm i.d., 1/32 inch o.d., 5 cm</td>
</tr>
<tr>
<td>205-00091</td>
<td>Tubing, PEEK-clad fused silica, 25 µm i.d., 1/32 inch o.d., 10 cm</td>
</tr>
<tr>
<td>205-00038</td>
<td>Tubing, PEEK-clad fused silica, 50 µm i.d., 1/32 inch o.d., 15 cm</td>
</tr>
<tr>
<td>205-00069</td>
<td>Tubing, PEEK-clad fused silica, 50 µm i.d., 1/32 inch o.d., 10 cm</td>
</tr>
<tr>
<td>205-00039</td>
<td>Tubing, PEEK-clad fused silica, 50 µm i.d., 1/32 inch o.d., 20 cm</td>
</tr>
<tr>
<td>205-00040</td>
<td>Tubing, PEEK-clad fused silica, 50 µm i.d., 1/32 inch o.d., 30 cm</td>
</tr>
<tr>
<td>205-00070</td>
<td>Tubing, PEEK-clad fused silica, 50 µm i.d., 1/32 inch o.d., 5 cm</td>
</tr>
<tr>
<td>205-00041</td>
<td>Tubing, PEEK-clad fused silica, 50 µm i.d., 1/32 inch o.d., 50 cm</td>
</tr>
<tr>
<td>205-00049</td>
<td>Tubing, PEEK-clad fused silica, 50 µm i.d., 1/32 inch o.d., 75 cm</td>
</tr>
<tr>
<td>205-00360</td>
<td>Tubing, PEEK-clad fused silica, 75 µm i.d., 1/32 inch o.d., 10 cm</td>
</tr>
<tr>
<td>205-00061</td>
<td>Tubing, PEEK-clad fused silica, 75 µm i.d., 1/32 inch o.d., 30 cm</td>
</tr>
<tr>
<td>5019620</td>
<td>Tubing, mobile phase, 5 ft</td>
</tr>
<tr>
<td>300-00054</td>
<td>Tubing, waste 5/16 inch i.d.</td>
</tr>
</tbody>
</table>
### Table B-1 Consumables and Accessories—Ordered by Description (continued)

<table>
<thead>
<tr>
<th>Part Number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>5017798</td>
<td>Sample loop, 2 µL PEEK-clad fused silica (no fittings included)</td>
</tr>
<tr>
<td>5017799</td>
<td>Sample loop, 5 µL PEEK-clad fused silica (no fittings included)</td>
</tr>
<tr>
<td>205-00054</td>
<td>Sample loop, 10 µL PEEK-clad fused silica (no fittings included)</td>
</tr>
<tr>
<td>5040770</td>
<td>Sample loop, 50 µL stainless steel</td>
</tr>
<tr>
<td>200-00452</td>
<td>Valve pod and fittings</td>
</tr>
<tr>
<td>200-00326</td>
<td>Valve rotor seal</td>
</tr>
</tbody>
</table>
Parameters for the Advanced Autosampler Script

Use this script for finer control over more autosampler functions.

Recommended values for the parameters and their ranges are listed in Table C-1.

**Note:** For a partial-loop injection, change the value for Rear Volume to 0.

### Table C-1 Parameters in the Parameter Setup Tab—Advanced Autosampler Script

<table>
<thead>
<tr>
<th>Parameter Name</th>
<th>Recommended Value</th>
<th>Minimum Value</th>
<th>Maximum Value</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>General Setting</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Tool*</td>
<td>LCP1</td>
<td>LCP1</td>
<td></td>
</tr>
<tr>
<td>Pump Module*</td>
<td>Pump 1</td>
<td>Pump 1</td>
<td></td>
</tr>
<tr>
<td>Cooled Stack*</td>
<td>Peltier Stack 1</td>
<td>Peltier Stack 1</td>
<td></td>
</tr>
<tr>
<td>Bottom Sensing Sample Vial (see note)</td>
<td>Off</td>
<td>Off or On</td>
<td></td>
</tr>
<tr>
<td>Height from Bottom of Sample Vial (mm)</td>
<td>2</td>
<td>0</td>
<td>32</td>
</tr>
<tr>
<td>Sample Temperature (°C)</td>
<td>8</td>
<td>4</td>
<td>40</td>
</tr>
<tr>
<td><strong>Sample Parameter</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Front Air Gap (μL)</td>
<td>3</td>
<td>0</td>
<td>3</td>
</tr>
<tr>
<td>Front Volume (μL)</td>
<td>0</td>
<td>0</td>
<td>5</td>
</tr>
<tr>
<td>Rear Air Gap (μL)</td>
<td>3</td>
<td>1</td>
<td>3</td>
</tr>
<tr>
<td>Rear Volume (μL)</td>
<td>2</td>
<td>0</td>
<td>5</td>
</tr>
<tr>
<td>Sample Aspirate Flow Rate (μL/sec)</td>
<td>15</td>
<td>0.1</td>
<td>50</td>
</tr>
<tr>
<td><strong>Injection Parameter</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Injector*</td>
<td>Injector LC 1</td>
<td>Injector LC 1</td>
<td></td>
</tr>
<tr>
<td>Sample Injector Flow Rate (μL/sec)</td>
<td>5</td>
<td>0.1</td>
<td>10</td>
</tr>
<tr>
<td>Pre-inject Delay (ms)</td>
<td>100</td>
<td>0</td>
<td>1000</td>
</tr>
<tr>
<td>Post-inject Delay (ms)</td>
<td>200</td>
<td>0</td>
<td>2000</td>
</tr>
</tbody>
</table>
### Parameters for the Advanced Autosampler Script

Table C-1 Parameters in the Parameter Setup Tab—Advanced Autosampler Script (continued)

<table>
<thead>
<tr>
<th>Parameter Name</th>
<th>Recommended Value</th>
<th>Minimum Value</th>
<th>Maximum Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pullup Delay (ms)</td>
<td>200</td>
<td>0</td>
<td>2000</td>
</tr>
<tr>
<td><strong>Wash Parameter</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Wash Station*</td>
<td>LCMS Wash 1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PreDip in Aqueous</td>
<td>1</td>
<td>0</td>
<td>2</td>
</tr>
<tr>
<td>PreDip in Organic</td>
<td>0</td>
<td>0</td>
<td>2</td>
</tr>
<tr>
<td>First Wash Solvent</td>
<td>2</td>
<td>1 or 2</td>
<td></td>
</tr>
<tr>
<td>Second Wash Solvent</td>
<td>1</td>
<td>1 or 2</td>
<td></td>
</tr>
<tr>
<td>Clean Valve Time with First Wash Solvent (s)</td>
<td>2</td>
<td>2</td>
<td>10</td>
</tr>
<tr>
<td>Clean Valve Time with Second Wash Solvent (s)</td>
<td>1</td>
<td>0</td>
<td>10</td>
</tr>
<tr>
<td>Clean Syringe Cycle with First Wash Solvent</td>
<td>1</td>
<td>0</td>
<td>10</td>
</tr>
<tr>
<td>Clean Syringe Cycle with Second Wash Solvent</td>
<td>1</td>
<td>0</td>
<td>10</td>
</tr>
<tr>
<td>Final Clean*</td>
<td>Off</td>
<td>Off or On</td>
<td></td>
</tr>
<tr>
<td>Final Clean with Wash Solvent</td>
<td>1</td>
<td>1</td>
<td>2</td>
</tr>
<tr>
<td>Final Clean Valve Time (s)</td>
<td>2</td>
<td>1</td>
<td>10</td>
</tr>
<tr>
<td><strong>Handshake Parameter</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Input Signal 1 (Pump Ready)*</td>
<td>Gr1Ready, GR 1Running, Gr2Ready, GR2Running</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Input Signal 2 (Pump Running)*</td>
<td>Gr1Ready, GR 1Running, Gr2Ready, GR2Running</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Output Signal (Start Gradient)*</td>
<td>StartGr1, StartG2</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Note:** The Bottom Sensing Sample Vial option might not be compatible with some vials, particularly glass inserts. If a different type of vial is to be used, then run a test sample using the new vial and make sure that the results are acceptable before setting up a complete run.
External Interface Connections

This section shows the external interface to other components. The external interface connections synchronize sample injection with data collection. The connector pin assignments are also described.

Table D-1 Pin Assignments for DB-25 Connector

<table>
<thead>
<tr>
<th>Pin Number</th>
<th>Function</th>
<th>Pin Number Mate</th>
</tr>
</thead>
<tbody>
<tr>
<td>Top Row (large side)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Aux out</td>
<td>14</td>
</tr>
<tr>
<td>2</td>
<td>Divert valve trigger</td>
<td>15</td>
</tr>
<tr>
<td>3</td>
<td>Not used</td>
<td>16</td>
</tr>
<tr>
<td>4</td>
<td>Not used</td>
<td>17</td>
</tr>
<tr>
<td>5</td>
<td>Valve out</td>
<td>18</td>
</tr>
<tr>
<td>6</td>
<td>Run out</td>
<td>19</td>
</tr>
<tr>
<td>7</td>
<td>TE mode</td>
<td>20</td>
</tr>
<tr>
<td>8</td>
<td>Rdy out</td>
<td>21</td>
</tr>
<tr>
<td>9</td>
<td>A/D ground</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Not used</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>A/D input</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>Prk in</td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>Run in</td>
<td></td>
</tr>
<tr>
<td>Bottom Row (small side)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>Aux out</td>
<td>1</td>
</tr>
<tr>
<td>15</td>
<td>Divert valve trigger</td>
<td>2</td>
</tr>
<tr>
<td>16</td>
<td>Not used</td>
<td>3</td>
</tr>
<tr>
<td>17</td>
<td>Not used</td>
<td>4</td>
</tr>
<tr>
<td>18</td>
<td>Valve out</td>
<td>5</td>
</tr>
</tbody>
</table>
External Interface Connections

Table D-1 Pin Assignments for DB-25 Connector (continued)

<table>
<thead>
<tr>
<th>Pin Number</th>
<th>Function</th>
<th>Pin Number Mate</th>
</tr>
</thead>
<tbody>
<tr>
<td>19</td>
<td>Run out</td>
<td>6</td>
</tr>
<tr>
<td>20</td>
<td>TE mode</td>
<td>7</td>
</tr>
<tr>
<td>21</td>
<td>Rdy out</td>
<td>8</td>
</tr>
<tr>
<td>22</td>
<td>Common ground</td>
<td></td>
</tr>
<tr>
<td>23</td>
<td>Common ground</td>
<td></td>
</tr>
<tr>
<td>24</td>
<td>Common ground</td>
<td></td>
</tr>
<tr>
<td>25</td>
<td>Common ground</td>
<td></td>
</tr>
</tbody>
</table>

Figure D-1 25-pin DB Connector Male Fitting

The 25-pin DB connector in Figure D-1 is a male connector viewed end on (that is, from the exposed male pin side and not from the hidden solder post side). D connectors have very small numbers inscribed on them indicating the pin numbers—a high power magnifier is often required to observe the numbers. Identify the numbers before creating or modifying connectors to the pump. When the connector cover is removed to solder new connections, the location of the pins might appear reversed. Verify the orientation before soldering. The common grounds are all tied together and can be used interchangeably.
## Glossary of Symbols

**Note:** Not all of the symbols in the following table are applicable to every instrument.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Australian Regulatory Compliance Mark" /></td>
<td>Australian Regulatory Compliance Mark. Indicates the product complies with Australian Communications Media Authority (ACMA) EMC Requirements.</td>
</tr>
<tr>
<td><img src="image" alt="Alternating current" /></td>
<td>Alternating current</td>
</tr>
<tr>
<td><img src="image" alt="Amperes (current)" /></td>
<td>Amperes (current)</td>
</tr>
<tr>
<td><img src="image" alt="Authorized representative in the European community" /></td>
<td>Authorized representative in the European community</td>
</tr>
<tr>
<td><img src="image" alt="Biohazard" /></td>
<td>Biohazard</td>
</tr>
<tr>
<td><img src="image" alt="CE Marking of Conformity" /></td>
<td>CE Marking of Conformity</td>
</tr>
<tr>
<td><img src="image" alt="cCSAus mark" /></td>
<td>cCSAus mark. Indicates electrical safety certification for Canada and USA.</td>
</tr>
<tr>
<td><img src="image" alt="Catalogue number" /></td>
<td>Catalogue number</td>
</tr>
<tr>
<td><img src="image" alt="Caution" /></td>
<td>Caution</td>
</tr>
</tbody>
</table>

**Note:** In SCIEX documentation, this symbol identifies a personal injury hazard.
## Glossary of Symbols

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="China RoHS Caution Label" /></td>
<td>China RoHS Caution Label. The electronic information product contains certain toxic or hazardous substances. The center number is the Environmentally Friendly Use Period (EFUP) date, and indicates the number of calendar years the product can be in operation. Upon the expiration of the EFUP, the product must be immediately recycled. The circling arrows indicate the product is recyclable. The date code on the label or product indicates the date of manufacture.</td>
</tr>
<tr>
<td><img src="image2.png" alt="China RoHS logo" /></td>
<td>China RoHS logo. The device does not contain toxic and hazardous substances or elements above the maximum concentration values, and it is an environmentally-friendly product that can be recycled and reused.</td>
</tr>
<tr>
<td><img src="image3.png" alt="Consult instructions for use" /></td>
<td>Consult instructions for use.</td>
</tr>
<tr>
<td><img src="image4.png" alt="cTUVus mark" /></td>
<td>cTUVus mark for TUV Rheinland of North America.</td>
</tr>
<tr>
<td><img src="image5.png" alt="Data Matrix symbol" /></td>
<td>Data Matrix symbol that can be scanned by a barcode reader to obtain a unique device identifier (UDI).</td>
</tr>
<tr>
<td><img src="image6.png" alt="Environmental Hazard" /></td>
<td>Environmental Hazard</td>
</tr>
<tr>
<td><img src="image7.png" alt="Ethernet connection" /></td>
<td>Ethernet connection</td>
</tr>
<tr>
<td><img src="image8.png" alt="Explosion Hazard" /></td>
<td>Explosion Hazard</td>
</tr>
<tr>
<td><img src="image9.png" alt="Fire Hazard" /></td>
<td>Fire Hazard</td>
</tr>
<tr>
<td><img src="image10.png" alt="Flammable Chemical Hazard" /></td>
<td>Flammable Chemical Hazard</td>
</tr>
<tr>
<td>Symbol</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td><img src="image" alt="Fragile" /></td>
<td>Fragile</td>
</tr>
<tr>
<td><img src="image" alt="Fuse" /></td>
<td>Fuse</td>
</tr>
<tr>
<td><img src="image" alt="Hz" /></td>
<td>Hertz</td>
</tr>
</tbody>
</table>
| ![High Voltage](image) | High Voltage. Electrical Shock Hazard  
If the main cover must be removed, contact a SCIEX representative to prevent electric shock. |
| ![Hot Surface](image) | Hot Surface Hazard |
| ![In Vitro Diagnostic Device](image) | In Vitro Diagnostic Device |
| ![Ionizing Radiation](image) | Ionizing Radiation Hazard |
| ![Keep dry](image) | Keep dry.  
Do not expose to rain.  
Relative humidity must not exceed 99%. |
<p>| <img src="image" alt="Keep upright" /> | Keep upright. |
| <img src="image" alt="Laser Radiation" /> | Laser Radiation Hazard |
| <img src="image" alt="Lifting" /> | Lifting Hazard |
| <img src="image" alt="Manufacturer" /> | Manufacturer |</p>
<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Moving Parts Hazard" /></td>
<td>Moving Parts Hazard</td>
</tr>
<tr>
<td><img src="image" alt="Pinch Hazard" /></td>
<td>Pinch Hazard</td>
</tr>
<tr>
<td><img src="image" alt="Pressurized Gas Hazard" /></td>
<td>Pressurized Gas Hazard</td>
</tr>
<tr>
<td><img src="image" alt="Protective Earth (ground)" /></td>
<td>Protective Earth (ground)</td>
</tr>
<tr>
<td><img src="image" alt="Puncture Hazard" /></td>
<td>Puncture Hazard</td>
</tr>
<tr>
<td><img src="image" alt="Puncture Hazard" /></td>
<td>Puncture Hazard</td>
</tr>
<tr>
<td><img src="image" alt="Reactive Chemical Hazard" /></td>
<td>Reactive Chemical Hazard</td>
</tr>
<tr>
<td><img src="image" alt="Serial number" /></td>
<td>Serial number</td>
</tr>
<tr>
<td><img src="image" alt="Toxic Chemical Hazard" /></td>
<td>Toxic Chemical Hazard</td>
</tr>
<tr>
<td><img src="image" alt="Transport and store the system within 66 kPa to 103 kPa." /></td>
<td>Transport and store the system within 66 kPa to 103 kPa.</td>
</tr>
<tr>
<td><img src="image" alt="Transport and store the system within 75 kPa to 101 kPa." /></td>
<td>Transport and store the system within 75 kPa to 101 kPa.</td>
</tr>
<tr>
<td><img src="image" alt="Transport and store the system within 10% to 90% relative humidity." /></td>
<td>Transport and store the system within 10% to 90% relative humidity.</td>
</tr>
</tbody>
</table>
### Glossary of Symbols

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Temp Icon" /></td>
<td>Transport and store the system within −30 °C to +45 °C.</td>
</tr>
<tr>
<td><img src="image" alt="Temp Icon" /></td>
<td>Transport and store the system within −30 °C to +60 °C.</td>
</tr>
<tr>
<td><img src="image" alt="USB Icon" /></td>
<td>USB 2.0 connection</td>
</tr>
<tr>
<td><img src="image" alt="USB Icon" /></td>
<td>USB 3.0 connection</td>
</tr>
<tr>
<td><img src="image" alt="Warning Icon" /></td>
<td>Ultraviolet Radiation Hazard</td>
</tr>
<tr>
<td><strong>VA</strong></td>
<td>Volt Ampere (power)</td>
</tr>
<tr>
<td><strong>V</strong></td>
<td>Volts (voltage)</td>
</tr>
<tr>
<td><img src="image" alt="Disposal Icon" /></td>
<td>WEEE. Do not dispose of equipment as unsorted municipal waste. Environmental Hazard</td>
</tr>
<tr>
<td><strong>W</strong></td>
<td>Watts</td>
</tr>
</tbody>
</table>
| ![Date Icon](image) | yyyy-mm-dd  
Date of manufacture |
### Glossary of Warnings

**Note:** If any of the labels used to identify a component become detached, contact an FSE.

<table>
<thead>
<tr>
<th>Label</th>
<th>Translation (if applicable)</th>
</tr>
</thead>
<tbody>
<tr>
<td>FCC Compliance. This device complies with Part 15 of the FCC Rules.</td>
<td>FCC Compliance. This device complies with Part 15 of the FCC Rules. Operation is subject to the following conditions: (1) this device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.</td>
</tr>
<tr>
<td>FOR RESEARCH USE ONLY. NOT FOR USE IN DIAGNOSTIC PROCEDURES.</td>
<td>FOR RESEARCH USE ONLY. NOT FOR USE IN DIAGNOSTIC PROCEDURES.</td>
</tr>
</tbody>
</table>
Index

A

acids, list of 11
acquisition batch
  creating 67, 72
  submitting 68, 73
acquisition method
  direct injection 64
  mass spec 64, 70
  trap-and-elute 70
Analyst Device driver
  installing 139
AutoCalPos.dam file 120
autosampler
  changing tray or plate type 106
  condensation 131
  configuration, retrieving 108
  flush gas 131
  injection port, replacing 83
  installation wizard 111
  maintenance 90
  scripts, importing 151
  settings, restoring 117
  syringe volume 160
  valve specifications 160
  wash solvents, replacing 90
autosampler script
  overview 23
  parameters for Advanced script 165
  parameters for Direct Inject script 24
  parameters for Trap Elute script 24
  selecting 66, 72
  vial bottom-sensing option 25, 166

B

bases, list of 11
buffers, list of 11

C

carryover 54, 62, 130
channels, selecting 16
chemical precautions, protective equipment 10
cleaning the system 76
column oven
  pre-heating 45
compound parameters 65, 71
consumables
  ordering 161
  part numbers 161
CTC PAL 3 driver, installing 146

D

Decontamination Forms and system returns 13
dimensions of system 159
direct injection
  acquisition method 64
  LC method 47, 55
  system configuration 38
  using Gradient 2 68
  valve plumbing 32
disposal
  chemicals 10

E

Eksigent Control software
  installing 140
  moving settings to a new computer 140
electrical requirements 159
electrode
  grounding 34
  installing in ion source 38
  selecting 38
environmental conditions, required 11
environmental health and safety regulations 7
external interface connections 167

F
flow rate
  appropriate electrode for 38
  available configurations 16
  guidelines for setting 123
  measuring 80
flow velocity 123
flowmeters, calibrating 81
flush gas 131
flushing
  electrode 124
  injection valve 44
  system 78
full-loop injection 21

G
gain and integral settings 157
Gradient 2
  direct injection experiment with 68
  disabling in acquisition method 65
LC method 52, 60
grounding, electrode 34
guard column 122
guidelines
  flow rate 123
  sample preparation 122

H
hardware profile
  activating 27
  creating 27
  verifying 26

I
I/O specifications 159
injection mode 21
injection port
  replacing 83
injection valve
  flushing 44
  sample loop, replacing 84
injection volume
  minimum 22
  setting 67, 72

L
LC method
  gradient 47, 55
  trap loading 60
  trap loading for low-flow 52
LCMS tool
  about 18
  priming 92
  pump module, replacing 92
  pumps, reconfiguring after replacing 93
  tubing, replacing 90
loading mobile phases 40
local regulations 10
low-flow system
  gradient method 47
  trap-loading method 52

M
maintenance
  autosampler 90
  personnel requirements 14
  pump 77
  valve 83
maintenance schedule 75
metered injection mode 22
microfluidic flow control 17
microtiter plate, configuring autosampler to use 106
minimum injection volume 22
mobile phase
  compatibility 11
  creating custom 43
  loading 40
  pH range 11
  purging and flushing 78
modifying the system 14
monitoring a run 68, 74
MS acquisition method 64, 70
N
needle
  replacing 98

O
ordering, parts and accessories 161
organic solvents, list of 11

P
PAL Virtual Terminal software
  installing 154
part numbers 161
partial-loop injection 20
personal protective equipment, precautions 10
plumbing diagram
  direct injection 32
  post-column 34
  trap-and-elute 33
pod, replacing 88
pressure transducers, initializing 77
pump
  maintenance 77
  selecting in software 16
pump seal rinse, replacing 78
purging the system 78

R
rapid injection mode 22
re-initializing pressure transducers 77
regulations
  local 10
rotor seal, replacing 84

S
Safety Data Sheets 10
sample carryover 160
sample drawers
  condensation inside 131
  cooling limit 160
  temperature, setting 97
sample loop
  position of sample inside 20
  replacing 84
sample preparation guidelines 122
sample, mass limits 122
SCIEX TripleTOF Systems
  calibration method template 120
seal rinse, replacing 78
source and gas parameters 64, 70
specifications 159
standard injection mode 22
storage instructions 158
syringe
  barrel, replacing 102
  needle, replacing 98
  plunger, replacing 102
system
  cleaning 76
  components 16
  connections, testing 45
  dimensions 159
  disconnecting 138
  installing 139
  maintenance personnel requirements 14
  moving 138
  returning to manufacturer 13
  sample capacity 160
  specifications 159
  storing 158
  use and modification 14
  weight 159
system configuration
  direct injection mode 38
  trap-and-elute mode 38

T
technical support requirements
theory of operation 17
trap column
  installing 36
trap-and-elute
  acquisition method 70
  Gradient 2 LC method 52, 60
system configuration 38
valve plumbing 33
Index

TripleTOF Systems
  calibration method template, modifying 117
troubleshooting
  autosampler 131
  column oven 130
  flow control 133
  moving to a new computer 157
  system initialization 126
  valves 127
tubing
  best practices 122

V
valve
  maintenance 83
  pod, replacing 88
  rotor seal, replacing 84
valve plumbing
  detailed instructions 36
  direct injection 32
  trap-and-elute 33

W
wash solvent tubing, replacing 90
wash solvents, replacing 90
weight 159

Z
zeroing pressure transducers 77